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Section 1:  Introduction to Asure ID 7 Software 
Asure ID 7 changes the paradigm of how ID card personalization software looks and feels. 
The new user interface and simplified processes make ID card template design and data 
entry an efficient, user friendly application.  

1.1  Interface 
Behind the friendly interface, Asure ID 7 is a productivity powerhouse with tools and 
capabilities to support the most sophisticated ID card applications.  

Whether you are new to ID badging or a power user, Asure ID 7 helps you design and 
produce ID cards and other secure credentials with unprecedented ease and efficiency. 

1.2  Navigating Asure ID 
If you have used the latest version of Microsoft® Office, the Asure ID 7 user interface will 
seem familiar. This is because it is based on the Microsoft Ribbon. Tab-driven navigation 
with convenient tools and fly-out control palettes makes using Asure ID 7 an efficient tool.  

1.2.1  Reviewing the Routine Tasks (designed within the software) 

The new Asure ID 7 user interface provides an excellent speed boost to designing cards and 
entering cardholder data. Everything you need to design and populate a card is right in front 
of you, and routine tasks can be performed with a couple of mouse click.  

1.2.2  Reviewing the Data Entry Center 

With this application, you can capture or load a photo, or add a digitized signature. a Data 
Entry Center with configurable on-screen data fields lets you set up an efficient data entry 
sequence independent of how the data appears on a card, or is structured in a database.  

1.2.3  Reviewing the Internal Database 

With the Asure ID 7 internal database, you can store card templates and cardholder 
information.  

1.2.4 Reviewing the Live Link Capabilities 

With Live Link™, you can also print card data from external databases such as HR, security 
or ERP. The Live Link Wizard sets up real time data exchanges with a few mouse clicks. At 
print time, Live Link accesses and delivers the data that populates the external data fields on 
each card. 

1.3  Product Overview 
Asure ID 7 is just one part of a complete, integrated system for the issuance, management 
and authentication of secure IDs. Your HID Global dealers can custom design a secure 
identity system using proven HID components including: 
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 Fargo ID Card Printer/Encoders 

 Cards, ribbons, films and overlaminates 

 ID card production management software 

 Digital cameras and photo accessories 

 ID card holders, lanyards and clips 

 ID card production services 

 HID contact and contactless card readers, including iCLASS® smart card readers 

Four Editions – Asure ID 7 
Asure ID 7 comes in four editions with increasing levels of sophistication.  

 For ID card applications that call for even greater control and integration into your 
organization, an Asure ID 7 SDK is also available.  

 This User Guide is designed to be used with all versions of Asure ID 7. 
Reviewing the Asure ID Solo™  Edition  
Ideal for smaller businesses looking for entry level ID card solutions. 

This edition provides an enhanced user experience for photo ID card design and data entry. 
Card data fields can be populated from the internal Microsoft Access™ database. 
Reviewing the Asure ID Express™  Edition 
Includes the advanced card design and batch printing capabilities. 

This edition adds features such as compound data fields, batch printing and conditional 
design and print rules. It can connect to an external Microsoft database. 

Reviewing the Asure ID Enterprise™  Edition 
Designed for larger organization that requires multiple operators and database applications. 

This edition offers expanded database connectivity and networking for enterprise class card 
issuance. It works with Microsoft Access and SQL databases and supports ODBC import and 
export. It supports School Interoperability Framework (SIF). 

The Enterprise edition can work with multiple tables within a single database.  
Reviewing the Asure ID Exchange™  Edition 
Advanced encoding, design and printing application with integration into enrolment, network 
and database applications.This edition is designed for the most sophisticated secure 
credential applications. It adds Oracle, MySQL, LDAP, SIF and DVTel® database support 
and works with multiple tables within multiple databases.  

 The iDIRECTOR™ encoding and management module improves smart card deployment and 
development.  

 iDIRECTOR manages how smart card applications are loaded onto cards, including card memory 
management in one encoding pass. 

 Third Party Encoding Option
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Section 2:  How to Install the Asure ID 7 
Software 
2.1 Installation Procedure 

Step Procedure 

1 Insert the Asure ID 7 CD and follow the instructions. 

Browse to the Setup.exe file if the CD does not autorun. 

2 Select the language for this installation in the Select Setup Language dialog. 

Click on Next to continue with the installation. 

Follow the prompts to FINISH the installation.  

3 First time setup: use admin / admin for the User Name and Password. 
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2.2 Step-by-Step Tutorial 
2.2.1 Designing a Card Template 

Step Procedure 

1 From the Application Icon, select the New Template selection.  

For Card Size, select Single Sided CR-80.  

For Orientation, select Portrait (Vertical).  
For Magstripe properties, select Magstripe. (Note:  The magnetic stripe is similar 
to a barcode and encodes information from your existing data fields.)  

For Technologies, select iCLASS.  

When completed, click OK. (Note:  If using a printer without a magnetic stripe 
encoder, select None for the Magstripe Properties selection.) 
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Step Procedure 

2 Select Single Card View on the lower Right-hand corner of the task bar. (Note:  
The Card Front should now be displayed.)  

If not, adjust the Zoom percentage next to the card view. 

3 Right-click on the background of the front the card and select Add Background.  

Select one of the default background images or select Browse… to choose one of 
your own.  
Once selected, click OK. 

4 All of the following Steps will be selected from the Home tab. 

5 From the Imaging group, select Photo. Click on the background image.  

Within the Image Properties dialog both the Border Color and Border Width can 
be modified at this time.  

When completed, click OK to close the Image Properties dialog. (Note:  Position 
the Photo precisely upon the background image.)  

6 From the Imaging group, select Image. Click on the background image.  

Within the Image Properties dialog, click the Load new Image from File link. The 
link will open a standard Windows Browse dialog.  

Browse and then, select the desired image. Click Open.  

Click OK to close the Image Properties dialog. (Note:  Position the Image on the 
background image.) 

7 From the Text group, select Text Label. Click on the background image. (Note:  
The Text Label Properties window will appear.)  

Type in some text, for this example we will use ABC Electronics, Inc. (Note:  
Within this dialog, the Font, Color, Height and Style can be changed to your 
liking.)  
When completed, click OK to close the dialog. (Note:  Position the item precisely 
upon the background image.) 

8 From the Text group, select Data Field. Click on the background Image. The Data 
Field Properties dialog will appear. Within the Field Name: field type in the word 
First and Last Name.  

Make sure that Text is selected as the Field Type. Make any necessary changes 
to the Font properties.  

Under Options, select the Reduce to Fit (or adjusted to fit your dimensions).  

Under the Data Field, select the Advanced Data Field Options link.  
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Type in a First and Last name within the Default Value: field.  

Change the Max Characters (maximum characters required): setting to 25. 

Click OK to close this dialog and then OK again to close the Data Field 
Properties. (Note:  Position the item precisely upon the background image.) 

9 From the Text group, select Data Field a second time. Click on the background 
Image. The Data Field Properties dialog will appear.  

Within the Field Name: field type in the word Position. Make sure that Text is 
selected as the Field Type. Make any necessary changes to the Font properties.  

Under Options, select the Reduce to Fit (or adjusted to fit your dimensions) 
selection.  
Under the Data Field, select the Advanced Data Field Options link. Type in a 
Position within the Default Value: field.  

Change the Max Characters (maximum characters required): setting to 25.  

Click OK to close this dialog and then OK again to close the Data Field 
Properties. Position the item precisely upon the background image. 

10 From the Text group, select Data Field a third time. Click on the background 
mage. (Note:  The Data Field Properties dialog will appear.) 

Within the Field Name: field type in the word Employee Number.  
Make sure that Numeric is selected as the Field Type.  

Make any necessary changes to the Font properties.  

Under Options, select the Reduce to Fit (or adjusted to fit your dimensions) 
selection.  

Under the Data Field, select the Advanced Data Field Options link.  

Type in a 5 digit number within the Default Value: field.  

Change the Max (maximum) Characters (required): setting to 5.  

Click OK to close this dialog and then OK again to close the Data Field 
Properties.  

Position the item precisely upon the background image. 

11 From the Barcode group, select Barcode. Click on the background image. (Note:  
The Barcode Properties dialog will appear.)  

Make sure that Code 39 is selected under the Type: designation. 

Under Select Fields, click on Employee Number within Available:. Click Add>>. 
(Note:  The number entered within the Employee Number field during enrollment 
will automatically populate the barcode.)  

Position the item precisely upon the background image. 

12 If using a printer without a magnetic stripe encoder disregard the next step, Save 
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your work and proceed to Data Entry.  

To save your work, select Save Template from the Application icon.  

Name the file and click OK to close the Save Template dialog. 

 

 
 

13 Click the Card Setup tab and then the Magstripe option from the Technology 
Group. This will launch the Magstripe Properties dialog. Select the Track 1 tab. 
(Note:  The magnetic stripe is similar to a barcode and encodes information from 
your existing data fields.)  

Under Select Fields, select First and Last Name. Click Add>>. Next, select the 
Track 2 tab.  

Under Select Fields, select Employee Number. Click Add>>.  
Click OK to close the Magnetic Properties dialog.  

The name entered within the First and Last Name field during enrollment will 
automatically populate Track 1 within the magstripe.  

The number entered within the Employee Number field during enrollment will 
automatically populate Track 2 within the magnetic stripe.  

14 Save your work and proceed to Data Entry.  

To save your work, select Save Template from the Application icon.  

Name the file and click OK to close the Save Template dialog. 
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2.2.2 Creating a Card with Data Fields  

The purpose of this Card Design is to enter data into Data Fields.  

Step Procedure 

1 Verify the following: 

Asure ID is installed on your PC. 

a printer is connected to the customers. 

The PC User is set up in the application. 

2 Launch the Asure ID 7 software. 

3 Enter your User ID and Password in the appropriate areas. 

4 Access the Card Design Center application. 

5 Access the Application Menu and select New Template from the dropdown 
menu. 

6 Select the attributes for the card (you want to create). Click OK. (Note:  The card 
surface will display the attributes of the card properties selected.) 

7 Navigate to the Text section on the Ribbon and select Data field. 

8 Drag/drop data object onto the card surface.  

9 Designate a Field Name for the object that will be displayed on the card surface, 
as well as in the data entry screen in the Data Entry application. 

10 Specify the data type by selecting from the list of radio buttons. (Note:  The 
default is text.) 

11 Specify additional property values or use the default values. Click OK. 

12 Select Print on Fluorescing Panel if this data should be viewed only with ultra- 
violet light.  

13 Select Save Template in the Application dropdown menu. 
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2.2.3 Creating a Card Template with an Image from file                       

The purpose of this Card Design is to enter an image from a file. 

Step Procedure 

1 Access the Card Design Center application. 

2 Access the Application Menu and select New Template from the dropdown 
menu. 

3 Select the attributes for the card (you want to create).  

Click OK. (Note:  The card surface will display the attributes of the card 
properties selected.) 

4 Navigate to the Imaging section on the Ribbon and select Image. 

5 Drag/drop the Image object onto the card surface in desired shape of field. 

6 Load the image from file by selecting to load the new image from the File link on 
the Properties window and (then) navigate to where the file is located. 

Select the file. (Note:  The image will be displayed in the preview box in the 
Properties window box.) 

7 Specify additional property values or use the default values.  

Click OK. (Note:  The image object will be displayed with the parameters 
established when the object was drawn onto the card surface.) 
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Step Procedure 

8 The image may be edited or proportionally cropped.  

a.  Click the “Edit Image” hyperlink 

b. Check the “Show Crop Box” checkbox. 

In Card Design, the aspect ratio used for cropping an image is now proportionate 
to the shape of the Image object placed on the card, instead of proportionate to 
the shape of the image loaded in. 

 

 
 

9 Select Print on Fluorescing Panel if this data should be viewed only with ultra 
violet light. 

Select Invert Image if this effect is required. 

10 Select Save Template in the dropdown menu. 
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2.2.4 Creating a Card with Photo Field  

The purpose of this Card Design is to enter a Photo Field from a database. 

Step Procedure 

1 Launch the  software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Card Design Center application. 

4 Access the Application Menu and select New Template from the dropdown menu. 

5 Select the attributes for the card (you want to create).  

Click OK. (Note:  The card surface will display the attributes of the card properties 
selected.) 

6 Navigate to the Imaging section on the Ribbon and select PHOTO. 

7 Drag/drop the photo object onto the card surface in desired shape of field. 

Option for rounded edges available in Properties.  
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Step Procedure 

8 

 

Designate a field name for the photo object that will be displayed on the card 
surface.  

Set up the Data Source or the Folder Data Source for image retrieval.  

Click OK to save the Photo properties. 

9 Select Print on Fluorescing Panel if this data should be viewed only with ultra 
violet light. 

Select Invert Image if this effect is required. 

 

10 From the Card Setup tab, select the Add a Data Source to connect to the Live 
Link data source. (Note:  This starts the Live Link Wizard to access the database 
where the photos are stored.) 

11 Follow the Wizard to establish connection to database. 

12 Select the specific table from the database. 

13 Select the specific field from the database. (Note:  The photo object will be 
displayed with the parameters established when the object was drawn onto the card 
surface.)  

14 Drag/drop data field object onto the card surface.  

Check the box for designating object as key field. 

15 Access the Advanced options to select table and field in linked database. 

16 Select Save Template in the dropdown menu. 
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2.2.5 Creating Magnetic Stripe Cards  

The purpose of this Card Design is to add Magnetic Encoded data to the card. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Card Design Center application. 

4 Navigate to the Card Setup tab on the menu Ribbon. 

Select the Dual-Sided Card icon in the technology section. 

5 Select Magstripe. (Note:  The Magstripe Properties are set for Type (ISO or 
Non-ISO or Custom) and Options.) 

6 Drop data objects onto the card surface based on the information required to be 
encoded on the magnetic stripe. (Note:  These may be set as non printable 
within the Properties window of that object.) 

7 Select the Magstripe tab to access Tracks 1, 2, and 3 (Properties). 

8 Select fields to be added to each track of the magnetic stripe. (Note:  The 
current field options are in the Available box.) 

Use Add to make that field active. 

9 Select Save Template in the dropdown menu. 
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2.2.6 Creating a Card with Compound Data field 

The purpose of this Card Design is to enter Compound Data Fields at Data Entry. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Card Design Center application. 

4 Access the Application Menu and select New Template from the dropdown 
menu. 

5 Select the attributes for the card (you want to create).  

Click OK. (Note:  The card surface will display the attributes of the card 
properties selected.) 

6 Navigate to the Text section on the Ribbon and select COMPOUND Data field. 

7 Drag/drop data object onto the card surface popping up the Properties window 
box. 

8 Designate a Field Name for the object that will be displayed on the card surface. 

9 Click on the Insert Data field link to add data to the field through the next 
Properties window box or click on the Insert existing data field link to use a data 
field that is already set up on the card template.  

0 10 Designate the field name for a field inside of the Compound Field and 
designates the type of field. 

11 Designate the Data Source as either a Data Entry or a Live Link Entry. 

12 Specify additional property values or use the default values.  

Please note that the font properties for each field inside of the Compound Field 
can set individually.  
Click OK. 

13 Continue with Steps 11 to 14 until all fields within the Compound Field are set 
up. 

 



© 2011 HID Global Corporation   All rights reserved 

26 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

Step Procedure 

14 Specify any additional options for the compound field (as needed) or use default 
values. 

15 Select Print on Fluorescing Panel if this data should be viewed only with ultra 
violet light. 

16 Select Save Template in the dropdown menu. 
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2.2.6 Creating a Card with a Photo Field  

The purpose of this Card Design is to enter a Photo Field from a file. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Card Design Center application. 

4 Access the Application Menu and select New Template from the dropdown 
menu. 

5 Select the attributes for the card (you want to create).  

Click OK. (Note:  The card surface will display the attributes of the card 
properties selected.) 

6 Navigate to the Imaging section on the Ribbon and select Photo. 

7 Drag/drop the photo object onto the card surface. 

8 Designate a field name for the photo object that will be displayed on the card 
surface in the Data Entry screen in the Data Entry application. 

9 Specify additional property values or use the default values.  

Click OK. (Note:  The photo object will be displayed with the predefined 
parameters. This is accomplished when the object was drawn onto the card 
surface.) 

 

 

 

10 Select Print on Fluorescing Panel if this data should be viewed only with ultra 
violet light. 

Select Invert Image if this effect is required. 

 

11 Select Save Template in the dropdown menu. 
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2.2.7 Using the Clone Feature  

Cloning is the act of linking a Data Field to another Data Field on the same Template. It is 
very similar to Template Binding, except that all Data Fields exist on the same Template and 
in the same card database.  
Step Procedure 
1 Clone a field by following these instructions: 

Create a field. 
Right click on the field and choose [Create a clone]. (Note:  This will work for Data 
Fields, Photos and Signatures, but not Compound Fields. Compound Fields 
themselves cannot be cloned, but they can create clone references to Data 
Fields. See below.) 
Clone fields will be read ONLY in Data Entry. 

a Data Fields that contains Clone references cannot be deleted until the Clone is 
deleted. (Note:  a clone can be deleted at any time.) 

The Fluorescing option may be used by checking the Print on Fluorescing 
Panel. 
(Note:  The field will appear on the template with the same name as the field that 
was cloned; however, it will also have the term clone and a number appended.) 
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Section 3:  Using the User Config Application  
3.1 Accessing User Config functions  
Click on the User Config icon to bring up this application. You can work with the Home tab or 
the View tab functionality. You can save your work by clicking on the Save icon in the upper 
left corner, as shown below. 

We have presented the functions in this application in a left-to-right Menu Bar review 
throughout this section. 
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3.1.1 Setting User Privileges 

These options may be set by the Administrator for each user account: 

Access Asure ID 7 via your Windows User ID and password. 

Access the Card Design application. 

Access the Data Entry application. 

Access the card printing function with in the Data Entry application. 

Access the User Configuration application. 

Access the Report application. 

Access the Program Options settings located under the application button. 

3.2 Selecting Home tab 
 

 
 

3.2.1 Selecting Clipboard – Cut, Copy, and Paste 
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3.2.2 Selecting Asure ID Users – Add User, Remove User, and Save 
Users 

To save all users in the user profile table, click the Save Users button on the ribbon. To 
delete a user, move the cursor to highlight the user in the user profile table, and then click 
the Remove User button on the ribbon. 

 
 



© 2011 HID Global Corporation   All rights reserved 

32 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

3.2.3 Adding Users 

Enter the appropriate User Name and Password to access the application. Use the 
appropriate upper and lower case. Check to ensure that the Caps Lock is turned off. 
(Important:  You should change the password for security reasons.) 

User ID (default): admin 

Password (default):  admin  

 

   
 



© 2011 HID Global Corporation   All rights reserved 

33 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

3.2.4 Adding Users (2) 

The User Configuration application allows the Administrator to create users for Asure ID and 
to set the profiles of what functions each user can access in the application.  

Step Procedure 

1 To create a new user, the Administrator would click on the Add User button on the 
ribbon.  

 
The Administrator may enter the user name, set the user ID and password, and set 
the appropriate privileges for this new user. 

When this is done, a blank row is added to the user profile table. 
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Step Procedure 

2 The Administrator can set the following:  

Customizable security settings per user and per groups. 

Security settings for users and groups on fields and templates. 

3 You can utilize Windows Authentication for the User Name and Password import. 

4 Open the VIEW to set how the layout will look.  

Record or Table view, Carousel or Single Row and Customize Layout. 

 

5 To use Customize Layout drag and drop the options in the order you prefer. This is 
done under the Template Card tab.  

See the View Layout to preview the data page. 

6 Select the Save icon to save the user profile. 
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3.2.5 Selecting Password – Change Password 

The purpose of this case is to change the Password. 

Step Procedure 

1 From the Password tab, enter and confirm the password for the user. 

2 Select the Save icon to save the user profile. 

3 To change a password, locate the record to be updated and make the changes.  
Click OK. 
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3.3 Selecting the View tab 

 

3.3.1 Selecting View – Record and Table 
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3.3.2 Selecting Record Views – Carousel and Single Row 

 

 
 

3.3.3 Selecting Layout – Customize 
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Section 4:  Using the Card Design Application 
You can use the Card Design Center to create the card layout for both printing and encoding 
objects. We have gone to great lengths to make this a user friendly, easy-to-follow 
application. (Note:  Each card layout is saved as a template for use by the Data Entry 
application for enrollment and printing.) 

4.1 Reviewing the Card Design Window 
You can use a simple drag-and-drop visual interface, while Asure ID takes care of creating a 
custom database for you behind the scenes. Controls are organized into logical groups. 
Groups are organized onto tabs Home, Card Setup and View as shown below. 

With the Asure ID's Card Design Center, you can: 

Layout and design a card template. 

Add technologies including barcode. 

Personalize your work environment including adding and removing Grid lines and Rulers as 
well as modifying the Card View, Orientation, Zoom Level and Properties. 

Link Data Fields to external data sources. 

Save, edit and export your work.  

In this section, you will find a comprehensive listing of all the options found in Card Design 
Center and your various corresponding functions. 

 

4.1.2 Toggling the Card Properties window 
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Click on this sidebar or the PIN display the Card Properties pane on the right side of the 
screen. (Note:   This is where the technology information, and any other card related 
information can be viewed.) 

 

4.2 Accessing the Card Design Application Menu  
You can click on the Application Menu button (located in the upper left corner of the 
window) to bring up the dropdown menu, as shown below.  

                                 
   

4.2.1 Creating a New Template- Card Design 
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Select New Template on the Application dropdown menu to bring up the New Template 
window and access the Create New Template or Sample Gallery capabilities.  

Select the Card Size. (Note:  The magnetic stripe is similar to a barcode and encodes 
information from your existing data fields.)  

Click on OK to save your work. Click on Cancel to exit without saving your work. 
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4.2.1.1 Selecting the CR-80 Card Size (Single Sided) 

Select the CR-80 (Singled Sided) card size to meet your specific card requirements. Here is 
an example of a selection.  

Note the boxes that indicate specific requirements (that need to be met).  

Those requirements are indicated under Card Properties in the lower right corner of the 
window. 

C-80 is the typical size of most identification and credit cards. 

Example – CR-80 (Single Sided, Portrait, Magnetic stripe, and iCLASS) 

 
 



© 2011 HID Global Corporation   All rights reserved 

42 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.2.1.2 Card Size (Dual Sided) 

Select the CR-80 (Dual Sided) card size to meet your specific card requirements. Here is an 
example of a selection. Note the boxes that indicate specific requirements (that need to be 
met). Those requirements are indicated under Card Properties in the lower right corner of the 
window. 

Example – CR-80 (Dual Sided, Landscape, Magnetic stripe, and HID Prox) 
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4.2.1.3 Selecting the CR-79 Card Size (Single Sided) 

Select the CR-79 (Singled Sided) card size to meet your specific card requirements. Here is 
an example of a selection.  

Note the boxes that indicate specific requirements (that need to be met).  

Those requirements are indicated under Card Properties in the lower right corner of the 
window. 

CR-79 is slightly smaller than the CR-80 and is usually adhesive-backed. 

Example – CR-79 (Single Sided, Portrait, None, and iCLASS) 
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4.2.1.4  Selecting the CR-79 Card Size (Dual Sided) 

Select the CR-80 (Dual Sided) card size to meet your specific card requirements. Here is an 
example of a selection. Note the boxes that indicate specific requirements (that need to be 
met). Those requirements are indicated under Card Properties in the lower right corner of the 
window. 

Example – CR-79 (Dual Sided, Landscape, Magnetic stripe, and HID Prox) 
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4.2.1.5 Selecting the Custom Card Size (Single Sided)   

Select the Custom (Single Sided) card size to meet your specific card requirements. Here is 
an example of a selection.  

Note the boxes that indicate specific requirements (that need to be met). Those requirements 
are indicated under Card Properties in the lower right corner of the window.  

Note the Custom Card Size dialog where you specify Unit, Width, and Height for your card 
requirements. 

Example – Custom (Single Sided, Landscape, Magnetic stripe, and HID Prox) 
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4.2.1.6 Selecting the Custom Card Size (Dual Sided) 

Select the Custom (Dual Sided) card size to meet your specific card requirements. Here is an 
example of a selection.  

Note the boxes that indicate specific requirements (that need to be met). Those requirements 
are indicated under Card Properties in the lower right corner of the window.  

Note the Custom Card Size dialog where you specify Unit, Width, and Height for your card 
requirements. 

Example – Custom (Dual Sided, Portrait, Magnetic stripe, and iCLASS) 
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4.2.1.7 Selecting Unit, Width, and Height (Custom Card Size) 

If you select Custom, you will be prompted to set the card size accordingly. You can bring up 
the same dialog for Single Sided or Dual Sided Custom Card Size. 

Select your Unit measurement by clicking on the DOWN arrow. 

Select your Width measurement by clicking on the UP or DOWN arrow. 

Select your Height measurement by clicking on the UP or DOWN arrow. 
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4.2.1.8 Selecting Card Orientation (Horizontal or Vertical) 

Select Landscape (horizontal) or Portrait (vertical) for your card orientation requirement. 
Before you make this selection, determine whether you want your card to be designed in a 
horizontal or vertical presentation.  

 

 
 

4.2.1.9 Selecting Magnetic stripe Properties (None or Magnetic 
stripe) 

Follow these instructions: 

Select Magnetic stripe if using magnetic stripe cards. (Note:  This card type has a magnetic 
stripe on your card with tracks that contain separate data.) 

Select None if not using magnetic stripe cards 
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4.2.1.10 Selecting Technologies (None, HID Prox, ICLASS, MiFare, 
or Command Line)   

 

Select None if you are not using HID iCLASS, Prox, MiFare, or Command Line (Third Party 
Encoding) cards.   

 
Select iCLASS if using a HID iCLASS card or compatible card formats. 

Select HID Prox for a proximity card or a compatible card format.  

Select MiFare for a MiFare card or a compatible card format. 

Select Command Line for a Third Party Encoding card format. 

After selecting the correct card the iDIRECTOR wizard will open. See  4.5  iDIRECTOR 
Access and Usage    

4.2.1.11 Confirming Template Changes 

Follow these instructions. (Note:  This allows you to confirm template changes that are made 
after you select New Template.) 

Confirm the template changes under the Card Properties.  
Click on OK, name and select Save Template to save your file.  

Click on Cancel to exit without saving your work.  

View a – Card Properties (lower right corner) 
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4.2.2 Opening an Existing Template 

Open Template allows you to select any previously-saved or imported templates. (Note:  
This allows you to work from pre-existing and predefined templates. Be sure and save your 
work after you make additions to your template.) 
Click on the Application Menu icon to open the Application Menu. 

Click on Open Template to bring up the Open Template window and access an existing, 
predefined template (for your use).  

Select the required template and click on OK to open up a template file.  

Click on Cancel to close out the window without accessing a template file. 

   

 

4.2.3 Closing a Template  

You can close a template by clicking on this icon after saving your template. 
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4.2.4 Saving a Template 

Follow these instructions to save your template at any given time. (Note:  Be sure and save 
your template periodically to avoid loss if your computer shuts down or locks up.) 

Click on the Application Menu icon to open the Application Menu. 
Click on Save Template to bring up the Save Template window. (Note:  This allows you to 
name (only if not previously named) and to save the Asure ID templates and their files.) 

    

4.2.5 Selecting Save Template As 

Follow these instructions to save your template at any given time. (Note:  Be sure and save 
your template periodically to avoid loss if your computer shuts down or locks up.) 

Click on the Application Menu icon to open the Application Menu. 
Click on Save Template As to save a new template or save an existing file as another file 
name. Click on Cancel to close out the window without saving a template file. 
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4.2.6 Managing a Template  

Managing a Template option allows you to rename or delete a selected template. Follow 
these instructions to bring up, select, rename, delete or alter a template or templates. (Note:  
This allows you to make changes or additions quickly and efficiently to your templates. Be 
sure and save your work.) 

Click on the Application Menu icon to open the Application Menu. 

Click on Manage Template to bring up the existing template window.  

Under Manage Templates, select the appropriate template.  

Select Rename template under Actions to rename the template (currently selected). Select 
Delete template under Actions to delete the template (currently selected). 

Click OK when you complete the procedure.  
OR  
Click Cancel to exit with out saving your work.  
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4.2.6.1 Setting up Asure ID (to load the last template on startup) 

Step Procedure 

1 Open Asure ID 7 and go to the Options menu. 

 

2 Choose the required Template in the column on the left side.  

Under Startup options, check the box for Restore last template used at startup. 
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4.2.7 Using the Bind and Un-Bind Template Option        

Template Binding is the act of linking to data from another Template.  
The purpose is to increase data consistency and reduce the number of times that the same 
data must be entered.  
A good example would be a School ID Card Template that contains a student ID, Name and 
Photo and a School Parking Permit Template. (Note:  This contains the same ID, Name and 
Photo, but with a totally different card layout/graphics.)                                                      
 
Step Procedure 

1 The types of objects (that can be bound) include the following:  
Data Fields  
Compound Fields  
Photos  

Signatures 

2 In order to bind to a template, that template must have at least one (1) non-
LiveLink Data Field defined; it must have been previously opened in Data Entry 
(so the Data Fields have been created in the card database).  
If the template has not been opened previously and you attempt to bind to it, you 
will be prompted to open the template in Data Entry and then try again to bind to 
it.  

3 When binding to a template, all the non-LiveLink Data Field will be copied from 
the Parent template to the Child template and the proper linkages will be set up 
in the Advanced Data Field Properties for each field to connect to the Parent. 
These linkages will be designated by a DataSource called “Template Bind”. 

4 Child Templates can contain Data Fields that are not bound to the Parent 
Template. These will be created in the Native database. 

5 Once a template has been bound to, the bound Data Fields cannot be deleted 
from the Parent, until all Child Templates are “Unbound”.  
The Parent Template cannot be deleted until all of its Child Templates have 
been “Unbound”.  
Child Template Data Fields and Child Templates themselves can both be 
deleted at any time.  
The act of Unbinding a Template will cause the link to the Parent Template to be 
severed; also, it will make the Native database the Primary DataSource for the 
formerly bound Data Fields. 

6 a Template that is already bound to another Parent Template, cannot be bound 
to by other Templates. (Note:  Basically, a Child Template cannot be used as a 
Parent Template.) 
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Step Procedure 

7 Open the BIND Template from the Application icon. Select the Template to 
Bind. 

Select the fields to BIND and delete the fields not needed for your application. 

Save this template with a different name.  

8 In Data Entry, the fields (you retained) will show up and will be filled with the 
appropriate data.  

 

4.2.8 Selecting the Import/Export option   

Follow these instructions. (Note:  This option allows you to choose one of four options 
relating to your templates.)  

Click on the Application Menu icon to open the Application Menu. 

Click on Import/Export to bring up the selection window.  

Select Import Asure ID 5.X Data and Templates, Import a Template, Import a Swift ID 
Template or Export a Template from the four choices, as shown below. 
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4.2.9 Selecting Import Asure ID 5.X Data  

Follow the instruction for Import Asure ID 5.x by clicking on this Welcome screen. (Note:  
This wizard will guide you through upgrading your templates and data for use with Asure ID 
6.) 
Click Next to continue. 

 

   
  

Select your Import Source by choosing a Source for importing templates and/or data. 

Click on the From File radio button to select an exported Asure ID 5.x Template (to import). 

Click on the From Database radio button to select an existing Asure ID 5.x Database (to 
import). 

Click on Next to continue. 
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Select a Template file by choosing an existing Asure ID 5.x template to import. 

Enter the complete path to the Asure ID 5.x Template. 

Click on Browse to select a template. (Note:   You must select a template in order to 
continue with this process.) 
Click Next to continue 
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4.2.9.1 Selecting Import Template from Swift ID 

Asure ID has the ability to import templates that were created by Swift ID, the integrated 
badging application in the DTC1000/4000/4500 card printers, into an Asure ID template.  

  
 

Click on the Application Menu icon to open the Application Menu. 

Select a file from the Import Swift ID Template from File. 

Then select your (swt) file. 

Click on Open to view the file. 

From here minor changes may be made. 

Save the template.                     
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4.2.9.2 Selecting Import Template from File  

Follow these instructions to import a pre-existing and predefined template from a designated 
folder. (Note:  This allows you to make changes, corrections, and additions to existing 
templates in a quick, efficient manner.) 
Click on the Application Menu icon to open the Application Menu. 

Select a file from the Import Template from File, as shown below. 

Then select your (xtp) file. 

Click on Open to view the file. 
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4.2.9.3 Selecting Export Template to File  

Follow these instructions to export a template from an existing folder. (Note:  This allows you 
to make changes, corrections, and additions to existing templates in a quick, efficient 
manner.) 
Click on the Application Menu icon to open the Application Menu. 

Select the file to export. 

Click on Save to export the file. 
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4.2.10 Previewing a Template 

Follow these instructions to review your template or templates. (Note:  This allows you to 
thoroughly inspect each template for corrections, additions, upgrades, and changes.) 

Click on the Application Menu icon to open the Application Menu. 

Click on Preview Template to bring up the Card Preview window. 

Select View Front, View Back, Zoom In, Zoom to Fit, Zoom Out or Print (as needed). 
(Note:  This window is for preview only and is not active to make changes.) 

If you select Print, the file will be sent to the default printer. (Note:  This is for previewing 
only.) 

Close the preview window from the upper right X when finished. 
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4.2.11 Printing a Template 

Follow these instructions to test how the template will look at review time. Follow these 
instructions to print a template. (Note: The completed card is printed in the Data Entry 
section after all the information has been added.) 
Click on the Application Menu icon to open the Application Menu. 

Select the desired Template from the Recent Template window. 

Click on Print Template to bring up the Print window.  

Click on the dropdown printer arrow and select the Printer option. 

Set up the Properties for the Printer Driver.  

Click on OK to print.  
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4.2.12 Exiting Asure ID (System Options) 

Caution:  This selection terminates the execution or closes the program for Asure ID. See 
the Exit Asure ID button in the lower right corner of the window. 

 

   
 



© 2011 HID Global Corporation   All rights reserved 

64 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.3 Home Tab 
The Home tab allows you to configure how that user data will be displayed.  

The Table view (shown above) is the default view and is used to show all users and all user 
settings.  

The Record view (shown below) is used to show individual records, either in a “carousel” 
view or in a single row view:  

Both views allow you to scroll through the data records and edit the appropriate data for the 
user‟s profile similarly to the table view. 

Select the required option by clicking on the Menu Bar icon then on the card. The property 
window will appear for editing. Using the items on the Home tab, you can perform these 
functions. Highlight the icon for the definition of each function.  

 
 

Each is described below. 

The Clipboard offers the Cut, Copy and Paste options. 

The Text offers the Text Label, Data Field and Compound Field used to edit the card. 

The Imaging offers the Photo, Signature, Image and Background options. 

The Shapes offers four (4) different drawing tools. 

The Barcode offers options to set up the Bar Code on the card. 

The Editing offers tools for object placement. 

These options are used by clicking on the icon and then on the card surface. (Note:   This 
brings up the properties menu for editing.)  

 



© 2011 HID Global Corporation   All rights reserved 

65 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.3.1 Copying an Object to Clipboard 

Cutting and Removing an Object from the Card Template 

 
 

4.3.1.1 Copying an Object to Clipboard 

This can be used for duplicating an existing object on the Card Template. 

 
 

4.3.1.2 Pasting an Object from Clipboard 

These two functions (above and below) can be used for copying and pasting an image from 
another application. 

Once an object has been cut or copied to the clipboard, place your cursor where you want it 
inserted and press the Paste icon. 
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4.3.1.3 Adding Text Fields 

You can use the Text Label object to place static text on the card. (Note:  Static text is fixed 
and is not variable.)   Select Text Label and click on card to place and find the properties 
box. Set properties as needed. 

Select the Text Label. Click on the card drawing surface and drag the text box to the desired 
size. When the mouse button is released, the application will then display the Properties 
window. 

At this point, you can enter the static text inside the Field Text box. In addition, you can set 
other properties of the text box by choosing the appropriate fields that are displayed by this 
window. 

After all options have been set correctly, you can return to the Card Design application by 
clicking on the OK button. 

This may be a Non Printable Entry, Conditional or to be printed with the Fluorescing Panel of 
the ribbon. 
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4.3.1.4 Masking Data Field Characters 

Step Procedure 

1 In the Data Field Properties window, select the Advanced Data Field Options 
window. See below. 
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Step Procedure 

2 Check the box for Mask Password Characters, located at the bottom of the 
Advanced Data Field Options window. See below. 
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4.3.2 Adding Image Fields 

The four (4) types of images (that can be added to the card design) are Portraits, Signatures, 
the images from files, and Backgrounds. 

The image files for the Photo or the Signature may come from the Data Entry database OR 
from files on the local PC file system. A checkbox will be provided on the Photo and 
Signature properties dialogs, which will hide the normal Data Source configuration controls 
and activate the controls for configuring a Folder Data Source.  

The folder path will be chosen by the user in the Photo and Signature properties dialogs. 
This offers the ability to store captured photos externally and save them to the local drive.  

The name of the Photo or image that will be associated with a folder image will be based 
another field on the template. Choose this field from a dropdown list on the Photo and 
Signature properties dialogs.   

You can use the Folder Data Source button to select the path from a standard Windows 
Folder Browser Dialog. (Note:  The Folder Data Source will not need to be configured in the 
Data Source Wizard like the other Data Sources in Card Design. The format of the image 
that will be used when an image is captured or loaded into Data Entry and saved will also be 
configured in the Photo or Signature properties dialog via a dropdown list.) 

See from below for each setup procedure. 
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4.3.2.1 Adding a Photo 

You can use the Portrait object to add a photo to the card template design. To begin the 
process, select the Portrait object in the Ribbon. 

 

 
 

Follow these instructions.  

Click on the Photo icon and then on the card drawing surface and drag the box to the 
desired size.  

When the mouse button is released, the application will then display this window. At this 
point, you can set the properties of the Portrait Field, including the source of the data used 
for the image.  

In addition, you can set other properties of the Portrait by choosing the appropriate fields that 
are displayed by this window. 

Select the Data Source or the Folder Data Source to retrieve the photos depending on where 
they are located.  

After all options have been set correctly, you can return to the Card Design application by 
clicking on the OK button. 
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DISPLAY A: DATA SOURCE will retrieve images from the database when in the Data Entry 
application. 

 
DISPLAY B: FOLDER DATA SOURCE will retrieve images from the local file system. 
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4.3.2.2 Adding a Signature 

The Signature object is used to add a bitmap of a signature to the card template design. To 
begin the process, you would select the Signature object in the Menu Bar. 

Click on the Signature icon; then click on the card drawing surface and drag the box to the 
desired size. (Note:   When the mouse button is released, the application will then display 
this Properties window.) 

Select the Data Source or the Folder Data Source to retrieve the signatures depending on 
where they are located.  

 

 
 

At this point, you can set the properties of the Signature Field, including the source of the 
data used for the image.  

In addition, you can set other properties of the Signature by choosing the appropriate fields 
that are displayed by this window. 

After all options have been set correctly, you can return to the Card Design application by 
clicking on the OK button. 



© 2011 HID Global Corporation   All rights reserved 

73 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

 

DISPLAY A: DATA SOURCE will retrieve images from the database when in the Data Entry 

application.   

 

DISPLAY B: FOLDER DATA SOURCE will retrieve images from the local file system.  
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4.3.2.3 Adding a Static Image 

The images from files object are used to add a static bitmap to the card template design.  

To begin the process, select the images object in the Menu Bar. 

 

 
 

4.3.2.4 Adding a Data Field 

You can use the Data Field object to create a text object that contains variable content. 
(Note:  The content will be either entered in the Data Entry application or alternatively will be 
linked to a database field.) 

Use this field to place a database-driven object. (Note:  This can be accomplished via the 
Asure ID internet database or connected to external database Live Link functionality.) 
Click on Data Field to insert a data field on the card. (Note:  Data Fields are Date Entry 
points connected to both internal and external databases.) This brings up the properties 
window. 
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4.3.2.5 Setting the Data Field Properties 

Click on the Data Field; then click on the card drawing surface and drag the text box to the 
desired size. (Note:  When the mouse button is released, the application will then display this 
window.) 
At this point, you can set the properties of the Data Field, including the type of data that will 
be contained in the field as well as the source of the data. (Note:  In addition, you can set 
other properties of the text box by choosing the appropriate fields that are displayed by this 
window.) 

After all options have been set correctly, you can return to the Card Design application by 
clicking on the OK button. 

This may be a Non Printable Entry, Conditional or to be printed with the Fluorescing Panel of 
the ribbon. 
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4.3.2.6 Editing a Condition in Data Field Properties 

This allows you to put conditions for a given field (e.g., the field “janitor” could be linked to 
one color background and “nurse” could be linked to another background.) 

Complete your selections below (as needed). 
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4.3.2.7 Using the Compound Field 

Compound Field allows you to concatenate multiple data fields into a single string. This can 
work with both Text Label and Data Fields. For example: combining First and Last Name 
together into a single field. (Note:  This allows you to combine multiple text and/or Data fields 
into a single string (e.g., first name, last name, so on). 

Use the Compound Field object to create a text object that contains variable content that 
consists of multiple data fields. (Note:  The content can be entered in the Data Entry 
application or alternatively linked to a database field.) 

Click on Compound Field to insert multiple text and data. Click on the card to place the 
compound field, the properties window will appear.  
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4.3.2.8 Setting the Properties (Compound Field) 

Once selected in the Ribbon, click on the card drawing surface and drag the text box to the 
desired size. When the mouse button is released, the application will then display this 
window 

At this point, you can set the properties of the Compound Field, including the data fields that 
will be included. In addition, you can set other properties of the text box by choosing the 
appropriate fields that are displayed by this window. 

After all options have been set correctly, you can return to the Card Design application by 
clicking on the OK button. 

This may be a Non Printable Entry, Conditional or to be printed with the Fluorescing Panel of 
the ribbon. 

Use the FONT SETTINGS hyperlink in the Data Field Properties for each individual field 
added to the Compound Field to set specific font details.  
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4.3.2.9 Using the Image Properties window 

This is a static object such as a corporate logo or another image. Follow these instructions: 

Click on the card drawing surface and drag the box to the desired size.  

When the mouse button is released, the application will then display this window. 
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4.3.2.10  Adding a Static Bitmap (to Card Template design) 

a static bitmap is an image which does not change. Company logos are examples. With this 
window, browse to the proper image file Load new Image from File.  
Search for the image file and then click the Open button. 

Select EDIT Image to find edit features for this image file. 

At this point, you can set the properties of the Image field, including the source of the data 
used for the image. In addition, you can set other properties of the Image by choosing the 
appropriate fields that are displayed by this window. 

After all options have been set correctly, you can return to the Card Design application by 
clicking on the OK button. 
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4.3.2.11 Using the Background Object 

The background object is used to add a static bitmap to the card template design for use as 
a background for the card. To begin the process, select the background object in the menu 
bar. 

4.3.2.12 Using the Background button 

Add or modify the card backgrounds as needed. 

 
 

4.3.2.13 Using the Background dropdown 

Add background to the front or back of the card, as needed. 

 

 
 



© 2011 HID Global Corporation   All rights reserved 

82 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.3.2.14 Using the Add a Background 

Follow these instructions: 

Click on the Background > Add a background to Front or Back to bring up the Background 
Properties window (being displayed). 
Select Browse to load a new background Image file. 
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4.3.3 Adding Image Shapes 

To add image of geometric shapes (i.e., lines, ellipses, rectangles) to the card, select the 
specific item in the Shapes group on the menu bar; then click on the Card Template to begin 
drawing.  

 

 
 

4.3.3.1 Selecting and Applying Lines 

Select the line from the menu bar and apply to the card surface. Once on the surface, the 
line can be resized and the properties can be displayed by double clicking on the line. 

 

 
 



© 2011 HID Global Corporation   All rights reserved 

84 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.3.3.2 Creating Cards with Non-printable Objects    

The purpose of this Card Design is to use non-printable objects on the card. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Card Design Center application. 

4 Access the Application Menu and select New Template from the dropdown 
menu. 

5 Select the attributes for the card (you want to create). 

Click OK. (Note:  The card surface will display the attributes of the card 
properties selected.) 

6 From the Home tab, select any Text option. 

7 Select the Text Label, Data Field or Compound Field option and drop it onto the 
card surface. (Note:  The Properties window box will be displayed.) 

 

 
 

8 Type in the name of the object in the Field Name. 

9 Select non-printable field checkbox in dialog. 

10 Make any additional changes to other attributes as needed.  

Click OK. (Note:  The object is displayed in the Card Properties right pane but not 
on the card surface.) 

11 Select Save Template in the dropdown menu. 
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4.3.4 Adding Barcodes 

To add a barcode to the card, select the Barcode item on the menu bar. Once selected, drop 
the barcode onto the card surface and this properties window box will be displayed. 
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4.3.4.1 Creating Cards with a Barcode   

The purpose of this Card Design is to use add a barcode to the card. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Card Design Center application. 

4 Access the Application Menu and select New Template from the dropdown menu. 

5 Select the attributes for the card (you want to create). Click OK. (Note:  The card 
surface will display the attributes of the card properties selected.) 

6 Navigate to the Home tab on the Ribbon. 

7 Select any Text option and drop it onto the card surface based on the information to 
be represented in the barcode. (Note:  Your card may already be designed and 
have the fields already setup.) 
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Step Procedure 

8 Barcode values are not visible on the card.  

Select non-printable field by clicking on the non-printable checkbox in the printing 
section of the Data Field Properties window. 

 

 

9 Type in field name to represent the barcode field. 

10 Select the type of barcode desired for the card.  See full list of options in Step 11. 
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Step Procedure 

11 Barcode Support Matrix provided below.   

Barcode Type Number/type of 
characters 

Check Digit 
Types 

 

2 of 5 any numbers NONE  

Codabar/NW-7 any  Optional 

Code 11 any MOD11 Optional 

Code 128 any MOD103 Automatic 

Code 39 any MOD43 

MOD10 

Optional 

Code 93 any MOD47 Optional 

EAN/UCC-128 any  Automatic 

EAN13 13 numbers MOD10 Optional 

EAN13+2 15 numbers MOD10 Optional 

EAN13+5 18 numbers MOD10 Optional 

EAN-8 8 numbers MOD10 Optional 

EAN8+2 10 numbers MOD10 Optional 
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EAN8+5 13 numbers MOD10 Optional 

Ext. Code 93 any (full ASCII) MOD43 Optional 

Ext. Code 39 any (full ASCII) MOD47 Optional 

Interleaved-2 of 5 number pairs MOD10 Optional 

ISBN  10/13 digit ISBN  Automatic 

UPC-A 12 numbers 1 Optional 

UPCA+2 14 numbers 1 Optional 

UPCA+5 17 numbers 1 Optional 

UPC-E 7 numbers 1 Optional 
 

Step Procedure 

12 Select the barcode icon on the Ribbon and drop it onto the card surface to bring up 
the Properties window. 

 

   
 

13 Select fields to be added to the active section in the dialog. (Note:  This data will be 
represented by the barcode.) 
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Step Procedure 

14 Select the Barcode Options tab in the Properties window box.  

 

 
 

15 Changing Barcode Options- Bearer Bars 
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Check Show Bearer Bars to include bars on the top and bottom of the barcode. 

 
 

 

16 Changing Barcode Options- Check Character 
Check Include Check Character to add a check digit to the barcode. Select the 
type of check character to include from the available types. 

 See Step 11 to view the Check Character support for the available barcode types. 

 

 

Step Procedure 

17 Changing Barcode Options- Show Barcode Text 

Check Show Barcode Text to add the text used in the barcode below it.  
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18 Changing Barcode Options 

The text properties for the barcode can be changed using the Font and Font Size 
menus on the Data tab. 

 

 
 

 
 

Step Procedure 

19 PDF 417 Barcode Options 

Select the PDF 417 for 2 Dimensional Barcode. 

 
 

20 PDF 417 Barcode Options-Data Compaction Mode 
Select a Data Compaction Mode to define how the data will be encoded into the 
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barcode. 

 

21 PDF 417 Barcode Options-Error Correction Level 
Set the Error Correction Level to set the amount of redundancy built in to the 
barcode image to allow for errors to be 

.  

Step Procedure 

22 PDF 417 Barcode Options-Data Columns 

Set the Data Columns to define the number of data/words included in the row of 
symbols within the barcode. 
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23 PDF 417 Barcode Options-Create Truncated PDF Symbols 

Check Create Truncated PDF Symbols to create a smaller, more compact version of 
the PDF417 barcode. 

 

 
 

 
 

Step Procedure 

24 DATASTRIP Type Options 

 

25 Changing the  Datastrip Options-Feature Length 

Use the Feature Length option to set the length of the individual elements of the 
barcode. 
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26 Changing the  Datastrip Options-Feature Width 
Use the Feature Width option to set the width of the individual elements of the 
barcode. 

 
 

Step Procedure 

27 Changing the  Datastrip Options-Error Correction Factor 
Set the Error Correction Factor to set the amount of redundancy built in to the 
barcode image to allow for errors to be corrected. 

 

28 Changing the Datastrip Options-Compression 

Select Use Compression Level to compress the data that is encoded into the 



© 2011 HID Global Corporation   All rights reserved 

96 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

barcode. This can be used to include additional information in the barcode itself.  

 

 
29 

Printing Option for all Barcode Types:  To print the barcode using the K panel of the 
ribbon only, select this option.  

 

30 Select Save Template in the dropdown menu. 
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4.3.5 Editing 

You can use the Arrange function in the menu bar to group objects together on the card 
surface and perform alignment between the objects. You can choose to align objects based 
on left edge, right edge, upper edge, or bottom edge. 

 

 
 

4.3.5.1 Aligning Lefts 

Use this section to align the left side of selected objects. Draw a box around the images 
which need to be aligned or click and hold Shift to group the multiple items. 

 

 
 

4.3.5.2 Aligning Rights 

Align the right edges of the selected objects with the right edge of the selected object. 
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4.3.5.3 Aligning Bottoms 

Align the bottom edges of the selected objects‟ with the bottom edge of the selected object. 

  
   

4.3.5.4 Aligning Centers 

Align the objects horizontally with the center of the selected object. 

 
 

4.3.5.5 Aligning Middles 

Align the objects vertically with the center of the selected object. 
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4.3.5.6 Center on Card Horizontally 

Center an object or a group of objects horizontally on the card. 

 

 
 

4.3.5.7 Center on Card Vertically 

Center an object or a group of objects vertically on the card. 

 

 
 

4.3.6 Fluorescing Panel Option   

Using the F-Panel (Fluorescing Panel) allows for the printer to print secure images that are 
invisible except when viewed under ultra-violet light.   
These Ribbons contain a yellow (Y), magenta (M), cyan (C), and resin black (K) panels to 
create a full color over-the-edge printing identification card.  

In addition, the Ribbon contains a dye-based fluorescing panel (F) which will allow you to 
print a standard or one-to-one personalized grayscale fluorescing image that is completely 
invisible until exposed to ultraviolet light. 
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4.3.6.1 Listing the Object Types (F-Panel) 

The object types that are supported by the F-Panel are: 
Text Label 

Data Field 

Compound Field 

Photo 

Signature 

Image 

Line 

Polyline 

Ellipse 

Rectangle 

Objects that are NOT supported on F-Panel are: 
Backgrounds 

Barcodes 

Magstripe 

(Note:   Refer to this guide for this Object Type description and how to use these options.) 

 

4.3.6.2 Required for Printer Support (F-Panel) 

Please see below: 

DTC400 & DTC 550 support 1-bit pixel, or monochrome images only. 

HDP5000 support 24-bit color images only.  

For non-Fargo brand printers and Fargo printers that do not support printing objects to the     
F-Panel, a message box will be displayed alerting the user that these objects will NOT be 
rendered. 

In order for this F-Panel option to function in a Fargo brand printer, the F-Panel ribbon and 
supported Driver & Firmware must be used. 

See the printer‟s user guide or HELP file for driver setup instruction. 

Text Properties dialog box with Print on Fluorescing Panel checkbox will allow the FIELD 
TEXT to print with the Fluorescing Panel viewed only with Ultra-Violet light. 
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The text will appear in a „bluish‟ tone on the preview so it can be differentiated from objects 
on the YMC panel. 

 

 
 
Photo Properties dialog box with Print on Fluorescing Panel checkbox will allow the 
PHOTO to print with the Fluorescing Panel viewed only with Ultra-Violet light. When the Print 
on Fluorescing Panel is checked the message box Invert F-Panel Image will appear 
checked. (Note:  This box may be turned off however the photos tend to look better when 
they are inverted.) 
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The photo will appear in a „bluish‟ tone on the preview so it can be differentiated from objects 
on the YMC panel. 

   A                               B 

 

This preview shows both the image being printed with YMC ribbon and the same image 
being printed with the F-Panel portion of the ribbon. Display B. 
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4.4 Card Setup Tab 
4.4.1 Layout 

You can use the Card Setup tab to set various properties of the physical card, including card 
layout, technology chip options and data sources used on the card. 

 

 
 

4.4.1.1 Selecting the Card Size (CR-79) 

As stated, select the Card Size (CR-79) as needed.  

 
 

4.4.1.2 Selecting the Card Size (CR-80) 

As stated, select the Card Size (CR-80) as needed.  

 
 

4.4.1.3 Selecting the Card Size (Custom) 
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Click on Custom to bring up the Custom Card Size dialog. 

  

 
 

4.4.1.4 Using the Custom Card Size window 

Select the unit of measurement.  

 
Choose the unit, width, and height from these options. 
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4.4.2 Orientation Options 

The Layout function is used on the Menu Bar to accomplish two functions. Select the Dual 
Sided Card if applicable. Select the orientation of the card as landscape (default) or portrait. 

You can change the card orientation to Landscape (horizontal orientation) or Portrait 
(vertical orientation). 

 

4.4.3 Technology Options 

The options here give the ability to describe what technology features exist on the card. 
Asure ID supports magnetic stripe cards and also supports smart cards that contain a solid-
state device (such as a memory chip) on which data can be stored. 

Select Magnetic stripe or Enable Smart Chips from the Technology options. 

 
Select iCLASS, MiFare, HID Prox, or Command Line from the Enable Smart Chips option. 
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4.4.3.1 Magstripe  

Select the Magnetic stripe option to bring up the magnetic stripe Properties window, shown 
below. See the below for additional information on this option. 

 
 

4.4.3.2 Setting the Magnetic Stripe Properties 

Set the properties in this window. 
Select ISO, Non-ISO or Custom under magnetic stripe Type. 

Select either Fill used space with zeros, Place Mag Stripe at bottom of the card or Remove 
the magnetic stripe from the card under Options. 

Enter data for each track by selecting the appropriate tab (Track 1, 2, or 3). Select the 
appropriate data field (that is to be used to supply the data). 
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4.4.3.3 Adding or Removing under Track 

To add a track, select from the left column and select the Add button. To remove a track, 
select from the right and select the Remove button. 

Add or remove a Data Field or a Text Label, as shown below. 

 
 

4.4.3.4 Enabling the Smart Chips 

You can use this option to designate which chip type is contained in the card (that will be 
used to produce the output). 

Click Enable Smart Chip to bring up the dropdown (shown below). 
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4.4.3.5 Selecting a Chip Type 

Asure ID currently supports HID Prox, MiFare, and iCLASS. After selecting a chip type, the 
application opens a side panel on the right portion of the PC‟s monitor.  

This panel is used to display the current chip type designated for this card and also is used to 
display the applications that are loaded onto this chip. 

Note that multiple chips can be configured for the card template (as needed) (i.e., HID Prox, 
MiFare, and iCLASS). 

SAM (Secure Access Module): SAM (Secure Access Module): Contact card, a SLE 88 
chip from Infineon, which holds the iCLASS keys and the iCLASS encryption/decryption 
algorithm. This contact smart card holds encryption & decryption algorithms required for this 
procedure. 
Command Line: Third Party Encoding Option:  
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4.5 iDIRECTOR Access and Usage 
This section provides the background, processes, and procedures to work with the 
iDIRECTOR feature. You will learn how to: 

4.5.1 Introduction 

With iDIRECTOR, you can use Asure ID to dynamically handle the addition of new Chip 
types.  

 iDIRECTOR allows other applications besides the SAM application to handle Key 
Management in Data Entry (Enter passwords prior to encoding). 

 Use application IDs, instead of application names (which can change) to manage 
iDIRECTOR objects in Card Design UI (formerly unavailable). 

 For more information on iCLASS Programming refer to: Appendix C- iCLASS 
Programming Guide 

 For more information on Command Line (Third Party Encode) refer to Section 4.6 

 

4.5.2 Description 

4.5.2.1 Adding an application for HID Prox , iCLASS, MiFare, or 
Command Line 

This uses the iDIRECTOR.  
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(Note:  The Tooltip is shown when you hover over any property in the Properties section of 
the General tab.) 

 

 

4.5.2.2 Memory Mapping   

For applications that support Memory Mapping (currently RFIDeas and Custom 
Application's), you can move a Fields Memory Mapping location with the Memory Mapping 
tab. 

You can drag and drop fields from one memory location to another 

Unavailable Memory Map locations will appear "grayed out". 

Feedback is provided when the field is dragged over an invalid memory location. 
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Click on Add an Application to start the iDIRECTOR Wizard. 
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Choose the application you would like to add on at this time.  

 
  

The Configuration Type for the application are chosen if the application has one; otherwise, 
this step is not followed.  Each option has specific Applications that may be added. RFIDeas 
Air ID (Write) is shown in the display below.  
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The application's properties can be configured if the application has any; otherwise, this step 
is not followed.  

You can finish the Wizard or cancel the add operation with the final screen. 

You can automatically create and Data Fields to each iDIRECTOR field with the "Create a 
Data Field for each iDIRECTOR Field" check box will allow. (Note:  If you choose not to do 
this, then you can manually create and link each field.) 
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4.5.2.3 Application Tabs  

Each Application (that is added in the Add Applications Wizard) has its own tab in the 
Properties dialog, which is used to access its settings.  

Each application's iDIRECTOR object properties are integrated into the application's tab in 
the Properties dialog. 

A set of hyperlinks for Password Management are available from the application's tab. (Note:  
See the Key Management section below for more details.)   

  

 
  

A Tooltip is shown when you hover over any property in the Properties section of an 
Application tab. 

Pressing the 'X' button on an application's tab will remove the application from the chip. 

Since the iCLASS Card Programming (SAM) Application has some special functionality, the 
Sam Status and password control are embedded into a tab, instead of using the standard 
application tab. 
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Refer to iCLASS Programing: Appendix C- iCLASS Programming Guide 

 
  



© 2011 HID Global Corporation   All rights reserved 

117 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.5.2.4 Advanced Encoding Options  

You can use this option to select the button for a card technology in order to view and edit 
the settings for that particular technology. (Note:  The setting names are different for iCLASS 
and Prox technologies; consequently, when upgrading from a previous version of Asure ID, 
those settings must be reapplied - before attempting to encode in Data Entry.) 

  

 
  

4.5.2.5 RFIDeas 

You can change each field's Book, Page, AppArea and Block location. (Note:  This is done 
using the Memory Mapping tab described in the Memory Mapping section, above.)   
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4.5.2.6 Custom Application Fields 

You must specify the Data Field Type, the Name of the field and whether this field are used 
to Read or Write data (in earlier versions of Asure ID, only Write Access was allowed). 

All Asure ID Data Field types except for Lists can be linked to a Custom iDIRECTOR Field. 
For Text fields, you can specify how the characters are written to the card. (Note:  This is 
done either as ASCII (1 byte) or Unicode (2 byte) characters.) 

For Text fields, a character limit will force you to choose a minimum number of blocks. This 
character limit will also be used when the Data Field is created as the Max Characters for the 
field. (Note:  This way you can never attempt to write more memory than you have mapped.) 

For Photo and Signature Fields, Max Bytes are used to force you to choose a minimum 
number of blocks.  

  

 
  

You must specify the Memory Map locations. If you do not select enough blocks to meet the 
Text Character Limit or the Max Bytes, you are prompted with an error message when you 
attempt to move on to the next page of the wizard. (Note:  You cannot proceed until the 
minimum Max Bytes are met.) 
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You can add additional fields by double-clicking on the Add Field item in the Fields section of 
the Custom Application's tab in the iCLASS Chip Properties Dialog (below). 

You can remove a field by right-clicking on a field and choosing the "Remove Field" menu 
item. 

You can change each field's Book, Page, AppArea and Block location using the Memory 
Mapping tab, as described in the Memory Mapping UI section (above).  
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After a Custom Field is added it can later be changed from a field that is written to the card to 
a field that is read from the card in the iDIRECTOR section of the Card Properties window by 
right-clicking on the Field and selecting the “Convert Field from Write to Read” menu item. 
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4.5.2.7 Key Management  

With this function, you can store the key(s) in the template in Card Design. A key can be 
applied at the Application level (across all Pages/AppAreas/Blocks) or at specific Page, 
AppArea or Block. 

You have the option to store keys with the template, or provide it at print time. 

You have the option to "Activate" or "Deactivate" a key embedded into the template in Card 
Design. 

You can choose how the key entered are used to authenticate the following: 

ASCII (single-byte) characters 

Unicode (two-byte) characters 

Hexadecimal - Indicates the string is interpreted as hexadecimal binary input. 

Integer - Indicates the string is converted to an unsigned 64-bit integer. 

You can check the "Show typed key" checkbox to see the key that you are typing. Each time 
you opens the Key Management dialog the key will still be masked. So there are no way to 
"see" a key after it has been entered (once the button OK has been pressed). 

To accommodate this in Data Entry, enter the key at print time if you do not want to store the 
key in the template.  
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4.5.2.8 SAM Status and Password Change 

If the SAM Status expects a configured card to be used, select YES. If not, select NO. 

Add the SAM Data and click OK to close the dialog.  

For more SAM Status information, refer to: Appendix C- iCLASS Programming Guide 
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4.5.2.9 Backward Compatibility 

Old iDIRECTOR objects (from templates created in Asure ID 6.4 and older) will automatically 
be removed to prevent any unknown side-effects. (Note:  No data shall be lost.)  

Only the iDIRECTOR objects will need to be re-added and re-linked to the Data Fields on the 
template, before any encoding operations can be performed. 

4.5.3 Step by Step Tutorial 

Follow these procedures as needed to use the iDIRECTOR feature. 

4.5.3.1 Reading the HID Access Data from a Prox card 

Step Procedure 

1 From the Enable Smart Chip menu, select the HID Prox menu item. 

2 When the Prox Properties dialog appears, press the “Add an Application” 
hyperlink. 

3 From the Add Application Wizard, press the Next button to get started. 

4 Choose the HID Access Control application from the list and press the Next 
button. 
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5 Select the format of the data to be read or press the “Auto Detect…” hyperlink to 
read the format directly from the Prox card. 

6 Press the Next button. 

7 If you press the Finish button at this point, a Data Field will be created and 
mapped to each field defined for the format selected in step 5.  

Press the Finish button to automatically create the Data Fields and exit the 
wizard. 
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4.5.3.2 Writing the RFIDeas application to an iCLASS card 

Step Procedure 

1 From the Enable Smart Chip menu, select the iCLASS menu item. 

2 When the iCLASS Properties dialog appears, select the iCLASS card type  (2k, 
16k, etc.) or press the “Auto Detect…” hyperlink to determine the card type directly 
from the iCLASS card. (Note:  This cannot be changed after an application is 
added, so be sure that this is correct, before proceeding.) 

3 Press the “Add an Application” hyperlink. 

4 From the Add Application Wizard, press the Next button to get started. 

5 Choose the RFIDeas Air ID application from the list and press the Next button. 

6 Select the Target Reader Type and press the Next button. 

7 Modify the Post Keystroke options in the Application Properties section as in the 
image below, to get the application to function properly when the card is presented 
for logical access. 

8 If you press the Finish button at this point, a Data Field will be created and 
mapped for all 3 fields used by the RFIDeas application.  

Press the Finish button to automatically create the Data Fields and exit the 
wizard. 
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4.5.3.3 Changing the MemoryMap for the RFIDeas application 

Step Procedure 

1 After an RFIDeas application is added, then fields for the RFIDeas application will 
appear in the Memory Map tab of the iCLASS properties dialog. 

2 Select the Memory Map tab. 

3 Click and drag the field to its desired new memory location. (Note:  Invalid memory 
locations will be restricted.)  

Depending on the card type (2k, 16k, etc.), the field may take up more memory 
slots when moved to an application area with more memory available, or less 
when moved to a memory location with less memory available. 

4 When the OK button is pressed on the iCLASS properties dialog, the changes will 
be applied. 

4.5.3.4 Setting an Authentication Key  

This is used by Asure ID to authenticate an iCLASS application area.  This should only be 
used for cards that have had application areas or sectors written to previously and have had 
the default key(s) for those application areas or sectors changed. 

Step Procedure 

1 After an application is added press the Set Authentication Key hyperlink. 
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Step Procedure 

2 Select the Activate Key radio button and enter the key into the Key and Confirm 
Key text fields. 

 

 
 

Step Procedure 

3 Use the options in the Key Type group to set how the key will be encoded for 
authentication. 

4 Press OK to embed this key into the template (encrypted). (Note:  This ensures 
that you will not be prompted to enter the key when the card is printed/encoded. If 
the key is entered incorrectly, you will be prompted at print/encode time for the 
proper key.) 
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4.5.3.5 Setting the Change Key  

This will be applied to an iCLASS application area when the card is printed/encoded. 

Step Procedure 

1 After an application is added press the Set Change Key hyperlink. 

 

 
 

Step Procedure 

2 Select the Activate Key radio button and enter the key into the Key and Confirm 
Key text fields. 
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Step Procedure 

3 Use the options in the Key Type group to set how the key will be encoded to the 
application area. 

4 Press OK to embed this key into the template (encrypted). (Note:  This is the key 
that will be written to the card, when the card is printed/encoded.) 
(Note:  If a key already exists at this application area, it must be authenticated to, 
prior to writing the new key. See the section “Setting the Authentication Key used 
by Asure ID to authenticate an iCLASS application area” for more information on 
this.) 
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4.6   Using a 3rd Party Command-Line Application to 
Encode Data to a Card 
As an extension to iDIRECTOR Smart Card Encoding, this feature is intended to 
allow for a stand-alone encoding or encoding and printing, via an established 
command line interface of a third-party provider.  Without this capability, all encoding 
of cards with Asure ID must happen through the built in iDIRECTOR driven encoding 
functionality. 
 
This feature supports the sending of a configurable card docking command, prior to 
the encoding operation.  In addition to PROX, Contactless (iCLASS and MiFare), 
move commands, 3rd party command-line applications support move to Contact 
station. 
 
Feedback from the 3rd party application is used to determine success or failure of 
the encoding operation as well as optional error messages that can be displayed to 
the user, in the event of a malfunction. 
 
Input to the application can be configured using optional parameters to mine data 
from Asure ID and send it to the application. 
 

Card Design Configuration  
A command line application can be added to a template in card design in 2 ways.  Via the 
Enable Smart Chips menu on the Setup tab: 
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Or, by selecting the Command-Line icon in the New Template dialog. 
 

 
 
Selecting either of these icons will present the user with a wizard for adding the 3 rd 
party technology to the template. 
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1. Press Next on the wizard‟s welcome page. 
 

2. You will be presented with the Application Configuration page. 
 
 

 
 

3. Specify the location of the third-party executable program that performs encoding as 
installed on the machine running Asure ID in the “Executable Path” text box.  Use the 
Browse link to surf to the location of the third party executable if that is easier. 

 
4. Specify the “Return File Path” if a Windows File will be used as the mechanism for 

returning the results of the encoding operation. If the Windows File is to be used, it 
will need to contain the text “OK” when the encoding operation is successful.  On 
encoding operation failure, this same return file can be used as the source for an 
error message to be displayed to the user (if “Suppress error messages checkbox is 
not checked). 
 

5. Check the “Suppress error messages” check box, if you would not like any error 
feedback presented to the user (not recommended) 
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6. Check the “Continue on User Prompt” to force the user to press a button on a popup 
dialog to continue the print process after encoding is completed (regardless of error 
status) 
. 

 

 
 

7. Check the “Use Executable Return Code” check box to use the command line 
executable RETURN code to determine success or failure, instead of using the return 
file.  Read the vendor documentation, to determine what, if any, return codes the 
application uses.  The OK Code text box shown above allows the user to configure 
the value that will be interpreted as “success”.  If this box is not checked, then the 
“Return File Path” must be used to determine success or failure of the encoding 
operation. 

 
8. Check the “Space Character Before Parameter Value” checkbox, if a space is 

required between the Command Prefix and the command‟s value. 
 

 
 

9. Choose which printer feed command will be sent to the printer to dock the card, prior 
to calling the command-line encoding application.  The options are as follows 

a. Prox 
b. Contactless (iCLASS and MiFare) 
c. Contact 
d. None 

If the 3rd party application will send the move command to the printer, then select 
“None” from the list. 
 

 
10. The timing of the encoding operation following the feed operation can be configured 

(in milliseconds) in the “Post Feed Delay” section above.  Asure ID does not wait until 
the card is docked to call the 3rd party after application after issuing the feed 
command.  If this delay is not specified, the application may be called before the card 
is docked. 

 
11. Press “Next” to go to the Error Handling page. 
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a. Select the “Abort printing process” radio button to abort the current and all 
subsequent cards (during batch prints), in the event an error is returned from 
the encoding application. 

b. Select the “Skip current card and continue” radio button to skip the current 
card and continue printing the subsequent cards (during batch prints), in the 
event an error is returned from the encoding application. 

 
c. Select the “Retry current card” radio button to retry the encoding operation a 

specified number of times in the event an error is returned from the encoding 
application.  Use the number edit field, pictured above, to specify the number 
of times to retry the card. 
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12. Press Next to go to the Add Parameter page of the wizard.  Select the type of 
parameter to output to the command line after the application‟s executable path. 
 

 
 
Static Text is a parameter that will be out put the command-line and will not change 
for all encoded cards.  The Command Prefix and the Command Text will be output 
with a space between them. 
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Database is for a parameter that is retrieved from the card record data at run time, 
and is based on a field name matching the template field name from the card 
template. This will fetch the specific data item from the template‟s values for a card 
and pass that as if it were literal text directly to the third party encoding application on 
the command line through a named parameter.  Select the type of data field to use.  
This field will be automatically created when the wizard is complete. 

 
User Prompt allows for the user to be prompted to enter a value at runtime, for each 
card being encoded.  This value will not be stored in the Asure ID database.  Enter 
the “Optional Prompt Message” to present the user with a custom message when 
they are prompted for the input. 

 
Batch Print Counter will pass in the value of the current batch print counter.  This 
counter is reset prior to each batch print operation. 
Global Print Counter will pass in the value of the global print counter.  This counter 
is not reset prior to each batch print operation, but is reset each time the application 
is restarted. 
 

13. After choosing a parameter type and configuring the parameter, Press Next. 
 

14. Press Finish to complete the wizard. 
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15. You will be presented with the Command-Line application dialog. 

16. Add any additional parameters needed by double-clicking the “Add Parameter” link in 
the Parameters section.  Remove incorrect or unnecessary parameters by right 
clicking and selecting “Remove Parameter”. 

17. Review your changes in the sample Preview section to see how the output will likely 
be output to the command-line. 
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18. Press OK to add the Command-Line application technology object to the template. 

19. Notice the object is added to the Smart Chip Applications area of the Card Properties 
window. 
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4.7   Live Link 
Follow this procedure. 

Step Procedure 

1 You can add, edit and delete records for these specific scenarios: 

A single data source exists on the template. (Note:  This can be native database 
or Live Link.) 

One Live Link table has been identified as primary and the Native database. 

Multiple Live Link tables and or data sources on the same template will be for edit 
only. (Note:  No adds or deletes will be allowed into the database in these Live 
Link tables.) 

You should include any number of fields that will be appended or added to the 
existing data using the native database. (Note:  These fields can be added, 
updated or deleted.) 

DVTel solution allows adds (new records), edits and deletes. (Note:  You can 
delete a record without removing the data, but changes the status of the card 
holder. No other data source can be used with DVTel, including the Native 
database.) 

LDAP will be read only and it cannot be used with any other data source, including 
Native database. 
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4.7.1 Setting up Live Link  

Step Procedure 

1 Information needed to SETUP Live Link 

Contact the database administrator to get connection string parameters for Live 
Link connections. 

Have the database user/password for the database you want to use. 

The defined users can have Select, Update, Insert and/or Delete privileges for the 
tables they will use with Asure ID 7. No other privileges are needed.  

The administrator will decide if the user can modify data through Asure ID or not 
modity it; and assign privileges to the database user to manage data integrity. 

In every Live Link connection users will see whatever objects have been assigned 
to the database username. Security is managed on the database side not within 
AsureID. 
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Oracle and DVTel will require client installations in order for Live Link to work.  

Oracle can use any client package that works with your version of DB for either 9i 
or 11g. 
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SIF is purchased as a separate program to support the School Interoperability 
Framework. 
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DVTel will provide the client package to your users. DVTel will use a Sybase 9.02 
client provided by DVTel. 
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Access, MySQL and SQLServer will not need additional client installs. 
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LDAP will not need any additional client software. 
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2 From Card Setup, select Add a Data Source. 

3 Click Next to continue. 

4 Select the Database Type from the list for your appropriate connection. 

5 When using the Access Database Type, other than the Native Database. (Note:  
Browse to the database using your appropriate password (optional).) 
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Step Procedure 

6 When using SQL Server Database Type, you will need the following: 

Server Name:  This is where the SQLServer database resides. 

Initial Catalog:  This is needed if you do not have a default database. This may be 
left empty. (optional) 

User Name:  This is the database username defined by the data administrator at 
the site. 
Password:  This is the password associated with the username. 
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Step Procedure 

7 When using Oracle 9i or 11g Database Type, you will need the following: 

Server Name:  This is the server name or IP address where the Oracle instance 
resides. 
Port:  This is the open port for this database instance 

SID:  This will be provided by Oracle Admin person at client site. (SID is a unique 
name for an Oracle database instance)   
User Name:  This is the database username defined by the Oracle data 
administrator at the site. 

Password:  This is the password associated with the username. 
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Step Procedure 

8 When using MySQL Database  Type you will need the following: 

Server Name:  This is the name or IP address of where the SQLServer database 
resides. 

Database Name:  This is the actual database the user needs to access. 

Port:  This is associated to the desired database. 

User Name:  This is the database username defined by the data administrator at 
the site. 

Password:  This is the password associated with the username. 
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Step Procedure 

9 When using DVTel Database Type. 
DVTel is an AsureID partner who uses our application to enhance/support your application. 
This solution has limited functionality and is a more scaled down Live Link connection.  
DVTel Live Link will be setup by DVTel personnel. Questions related to this connectivity 
should go through DVTel support. 
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Step Procedure 

10 The DVTel has these requirements: 

Asure ID 7 users must have a template group number set. 

When users are mapping a template that already has a name (ie: imported 
template) and both the template name and AsureID users template group number 
match an existing data source from DVTel, it will automatically be assigned and 
users will not be required to pick the primary data source. 

Employee ID is a mandatory field on every template. It can be a non-printable field.  

Status is also a mandatory field on every template and can also be non-printable, if 
users intend on adding, suspending and/or deleting records. 

Need to have installed Sybase client. This would come from DVTel. 

All data fields on a DVTel template must be mapped to a DVTel data source.  

 11 When using LDAP Database Type, apply the following: 

Search root is the suffix or desired root you want. 

The LDAP Authentication Support module determines whether a simple password 
is sufficient or other challenges are required.  

Implementation of the module in Dynamic Server takes advantage of the fact that 
for explicit connections, a password is sent to the server by the client.  

This password can be used to satisfy the LDAP Authentication Support module in 
cases where a simple password is used.  

When the authentication mode involves responding to single or multiple 
challenges, the applications must be able to respond to the challenges. 

Users will need to get user/password as well as above information from your LDAP 
System Administrator. 

12 SIF is purchased as a separate program to support the School Interoperability 
Framework. 

13 Once the database has been connected, two more windows need to be 
addressed: these are optional setups. 
Identify the Default Table (optional). (Note:  This table will automatically show 
whenever you map data from the dropdown box. Once set it will be saved.) 

Select the Primary Table (optional). (Note:  This table will be the driver for data 
retrieved regardless of how many other data sources and tables are added.)  

When adding multiple data sources, the primary table will be overridden with each 
choice.  
Selecting <None> means that the native database will be primary. 
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Click on Next. 

14 Click the Test button to verify the connection is successful. 

Click Finish. 

15 Dynamic Lists are available only through Live Link. 
Dynamic lists are a list of values that comes from a second table.  

Setup will require establishing the relationship in two places. Dynamic lists do not 
work using the same table for the data source and the list source. 

Determine which field on the card will be a list field and choose the List datatype 
for that field. 

Click on Advanced Data Field Options to perform the mapping. 
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Step Procedure 

16 Under Data Source, identify the field in your cardholder table that will get updated. 
(Note:  The datatype of this field MUST match the key from the Dynamic List Data 
Source, which is not the text value you can see.) 

 

  
  

 

Step Procedure 

17  Force Upper Case - Choosing this option will force the text entered into this field 
to always be saved in the database and printed on produced cards in uppercase, 
regardless of the case that the data was entered into. This option will have no use 
at all for fields that use the 'Number' data type. 

If the case is forced it will not affect the data in the database, it will only be 
rendered to the card and the preview mode in the forced case. 
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Step Procedure 

18 Pick Lists can be used with or without Live Link. Here is a description of this 
process. 

It is the ability to customize a list of values that a you can see for this field when in 
data entry. The value created is the value that will be stored in the data. 

This is only available with data fields that have a data type = text. 

In this example, the user creates a field called status and the field type is set to 
text.  

In Advanced Data Field Options select the ALLOW TYPING VALUE IN DATA 
ENTRY to manually type the text rather than choose from the Picklist.  This is set 
for that record only and is not added to the picklist to be available by any other 
record.   
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Step Procedure 

19 Click on [Manage the Picklist]. 
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Step Procedure 

20 Click on [Add an item]. 

 

 
 

Step Procedure 

21 Click OK and continue to build the list. 

 

 
 

Step Procedure 

22 Click OK and when in Data Entry these are the list of values you can see. Since 
there was no default set, the field defaults to <NULL> or blank. (Note that other 
values can be typed in the pick list field, but will not be stored in the actual list that 
is managed from Card Design. 
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4.7.2 Data Sources 

For details, refer to Using the Multi Live Link Options (Advanced User Level) 
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4.7.3 Creating Live Link Connections   

Step Procedure 

1  

You can use the wizard to create Live Link connections for a template. 

See Using the Live Link Capability above.  

Enter database connectivity parameters. 
Enter a user and password with appropriate privileges. 
 

2  
Once connected to the chosen data source, choose a Default Table. (Note:  This 
will appear in dropdowns when they map to their respective Data Fields.) 
 

 
 

3  
Choose the Primary table. (Note:  Once chosen, this table will be the source of all 
records and can be thought of as the parent table. The key field to this table will 
need to exist in any other Live Link tables used in the template.) 
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4 When you add multiple Live Link sources, the Primary Source must be the last 
addition. If this does not occur, return to the wizard and change the primary 
source. 

The values in the keys must match for every data source used on the template. 
(Note:  The field names do not need to match.)  

Fields left unmapped will automatically get created in the Native database, using 
the key field from the Primary table. (Note:  This happens when the template gets 
saved.) 

5 Review these Primary Rules and how they apply: 
The table defaults to Primary IF you add one Live Link table to the template and do 
not choose a Primary table, when the template is saved.  

a warning will state that a Primary data source is needed IF you add multiple Live 
Link tables to the template and do not choose a Primary table (when saving the 
template). Correct this before proceeding with procedure.  

(Note:  The template will be saved; however, Data Entry will not function until a 
Primary table is chosen.) 

6 Review how keys are defined in the native database template table. 
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7  
You can add multiple Live Link data sources and put fields on the template that are 
not linked to Live Link. These fields get stored in the Native database in a table 
with the same name as the template name.  
 
The key to this table is defined in one of three ways: 
 
The Record ID becomes the key with these conditions: 
No other auto incremented fields are defined on the template, using Data Entry as 
the data source.  
 
No Live Link-mapped fields exist on the template. 

The auto incremented field will be the Primary key with these conditions: 
An auto incremented field is defined, using Data Entry as the data source. 
 
No Live Link-mapped fields exist on the template. 
The template key will be defined as the key on the last Live Link table/field added 
to the template IF a Live Link table/field is on the template. 

4.7.4 Using the Multi Live Link Options (Advanced User Level)   

This allows you to link to multiple databases in Live Link.  

Step Procedure 

1 You can add and edit records for these specific scenarios: 
a single data source exists on the template. (Note:  This can be native database or 
Live Link.) 
One Live Link table has been identified as Primary and the Native database. 

Multiple Live Link Tables and/or data sources on the same template will be for edit 
only. (Note:  No adds or deletes will be allowed into the database in these Live 
Link tables.) 

You should include any number of fields that will be appended or added to the 
existing data using the native database. (Note:  These fields can be added, 
updated or deleted.) 

DVTel solution allows adds (new records), edits and deletes. (Note:  You can 
delete a record without removing the data, but this changes the status of the card 
holder. No other data source can be used with DVTel, including the Native 
database.) 

LDAP will be read only; also, it can be used with the Native database. 

 



© 2011 HID Global Corporation   All rights reserved 

164 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4.8 Using the View Tab in Card Design  

 
4.8.1 Viewing Front 

Select View Front under View. (Note:  This allows you to view only the front of the card.) 

 

4.8.2 Viewing Back 

Select View Back under View. (Note:  This allows you to view only the back of the card.) 
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4.8.3 Snap To Grid 

Toggle the Snap To Grid when the objects are moved or resized with this option. (Note:  
This allows you to snap to the grid.) 

 
 

4.8.4 Using Rulers To Fit the Card into View 

Zoom in on the card as much as possible to fit the current view. (Note:  This allows you to 
obtain a complete, accurate view of your card design). 
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4.8.5 Zooming in on the active Card Side 

Zoom in on the active card side (as needed). You can enlarge the image from 25% to 800%. 
As a general rule, 100% and 200% zoom is ideal. (Note:  This allows you to efficiently zoom 
in or out as needed for viewing and editing purposes.) 

 
 

 
 

4.8.6 Zooming Out on the Active Card Side 

Zoom out on the active card side (as needed). (Note:  This allows you to view your entire 
card layout and design for further editing purposes.) 
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4.8.7 Selecting Show / Hide 

Toggle to turn on or off the options for Gridlines, Rulers or Card Properties. 

 

4.8.8 Selecting Gridlines 

Toggle the gridlines on and off with this capability. (Note:  This allows you to choose whether 
or not to display gridlines on the card surface) 

 
 

4.8.9 Selecting Ruler Units 

Select Inches, Millimeters, Pixels, Points or Document under Ruler Units with this option. 
(Note:  This allows you to choose whether or not to display the horizontal and vertical ruler in 
the card design center. This is a full ON or OFF function.) 
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4.9 Using Record Views in Data Entry 
Follow this procedure. 

Step Procedure 

1 Select Data Entry, and then select the View tab. See below. 

 
  

2 View the Record Views options and select as needed. 
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Section 5:  Data Entry Application 
The Data Entry application allows you to populate the database created in the Card Design 
Center with the appropriate data for the card and then print the designated cards. 

You can access the workspace for this application. (Note:  It is divided into two sections, 
which are the record display area and the preview area. The record display area occupies 
the middle portion of the screen and the preview area occupies the right side of the display 
area.) 

You have two views in the Data Entry application. (Note:  The default view shows a single 
record in a form layout. Upon entering the application, the form will be populated with the first 
data record from the data set (if there is data in the data set).)  

You can navigate through the data records by using the Next, Last, Previous, and First 
buttons. (Next to the Record X of X at the bottom) 

5.1 Selecting the Home tab 
You can use the items on the Home tab to perform these functions. Highlight the icon for the 
definition of each function.  

The Clipboard offers the Cut, Copy and Paste options. 

The Records offers the Save, Add, Add Batch and Delete for managing the records in the 
database. 

The Acquire offers the Capture and Load from File options. 

The Find offers Find, Replace and Filter tools. 

The Select offers options to Select and Deselect All records. 
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5.1.1 Selecting Clipboard – Cut, Copy, and Paste 

 

 
 

5.1.2 Selecting Records – Save, Add, Add Batch, Delete, and Void 
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5.1.2.1 Voiding a Record (Data Entry) 

The Records group contains the VOID function. There is no function to “un-void” a record, so 
the void action is permanent. Select All and Select Record do not select voided records. 
Voided records cannot be printed. 

Step Procedure 

1 Select the record to be voided from Data Entry Application. 

 

 
 

Confirm the Void Record verification window. There is no function to “un-void” a 
record. 
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If the record is needed again, it must be added again. If unique fields are used, the 
voided record should be deleted before it is added again. 

Select All and Select Record does not select voided records. 

2 Voided records cannot be printed. After a record has been voided, it can no longer 
be edited. The data fields are disabled, and shown dimmed gray. The preview will 
also show “Void” across the card. 

 

3 By default, the Voided column is not displayed. Right-click on the column names to 
open the Column Chooser.  

All the internal database fields are listed, including Voided, and can be dragged from 
the Customization window and dropped onto the grid to be displayed.  

To remove the column from the display, open the Column Chooser and drag the 
column off the grid into the Customization window. 
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4 All the internal database fields are listed, including Voided, and can be dragged from 
the Customization window and dropped onto the grid to be displayed.  

To remove the column from the display, open the Column Chooser and drag the 
column off the grid into the Customization window. 

 

 

 

 

5.1.3 Selecting Acquire – Capture and Load From File 
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5.1.3.1 Load from File  

The purpose of this case is to print a card using Photo Capture. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Go to the Data Entry application. 

4 From the Application menu, select Open Template from the dropdown menu. 

5 Add a record by going to the Records option on the lower bar using the + or – sign 
to either add or delete a record. 

 

 
 

6 Click on Photo Field in the added record. 

7 From LOAD from FILE icon the select the desired photo. Or right click into the 
PHOTO box and select from the dropdown. 
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8 Select the picture and modifies the location of picture box (if necessary) for the 
dimensions established in the card template. (Note:  This allows you to get the 
proper placement of the person‟s face in the field.) 

9 Click OK and the photo is imported into the photo field. 

10 Click the Save icon on the Records option. (Note:  a preview rendering of the card 
will display on the right hand preview pane.) 

 

 

11 Click on the Print icon next to the Application Menu or open the menu for the print 
options. 

5.1.3.2 Photo File  

Step Procedure 

1 From the Application icon, select Open Template. (Note:  From the Open 
Template dialog choose the template and click OK.) 
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2 If capturing a photo from a digital camera (or similar) click on the Application icon.  

Click Options and then Devices.  

Select Camera Type, TWAIN or WIA. Click on the camera from the list of capture 
devices, when completed click OK to close the Options dialog. 
 

 
 

3 From the Records group, select Add. (Note:  The enrollment dialog will appear.) 
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4 Right-click in the Photo field to Capture Image, Load Image from File, Edit Image, 
Delete Image or Save Image to File.  

Select Capture Image if working with a digital camera. The Select Source dialog 
may appear.  

Choose the camera and click Select to close the dialog.  

Take the Photo. 

Double click on the photo to display the Edit Image dialog.  

Click and drag the Crop tool, redraw the rectangle around the image and click OK 
to close the Edit Image dialog. 

 

 
  

5 Enter Data for the rest of your data fields.   

6 Click Save within the Records group. (Note: Once the Save button has been 
selected the fields with the Preview will all be filled in.) 
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7 Repeat Steps 4 to 6 as many times as wanted. 

8 Select Print / Print Card icon from the application menu to print a card.  

Select the printer from the Name: dropdown menu.  

Select Properties to change the card orientation or any other settings relevant to 
the card design.  

When completed, click OK to print a card and close the Print Card dialog.  
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5.1.3.3 Signature File 

The purpose of this case is to print a card with a Signature.   

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Go to the Data Entry application. 

4 From the Application menu, select Open Template from the dropdown menu. 

5 Add a record by going to the Records option on the Home Tab. 

      6 From the AQUIRE option click on the Capture (select Signature) or LOAD from 
FILE icon the select the desired photo.  

Or right click into the SIGNATURE box and select from the dropdown. 

If you set up the FOLDER DATA SOURCE option refer to  Adding a Signature  

7 Select the signature and modifies the location of picture box (if necessary) for the 
dimensions established in the card template. This allows you to get the proper 
placement of the signature in the field. 

8 Click OK and signature is imported into the signature field. 

      9 Click the Save icon on the Records option. A preview rendering of the card will 
display on the right hand preview pane. 

 

10 Click on the Print icon next to the Application Menu or open the Application Menu 
for the print options 

11 To edit the Signature field, right click on the signature to bring up the option box.  
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5.1.4 Selecting Find – Find, Global Find, Replace, Quick Filter, Clear 
Filter, and Show Filter 

 

 

 

5.1.4.1 Global Find 

Step Procedure 

1 In the Data Entry application, select the Home tab to view the Global Find icon in 
the Ribbon. See below for navigation to this specific function. 
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2 In the Global Find search window, you have two choices: 

Perform a simple search on a single table.  

OR 

Search for a piece of information throughout selected templates or throughout all 
templates. (Note:  You can also search through all of the Data Views, which are 
saved.)   

The proper options for each search are defined within the Global Find window.   

Click on the Start Search button to begin the process (once all search criteria is 
filled out).  
Use the Pause Search button to stop the search at the next break in the search.  
(Note:  This window can be minimized to run the requested search in the 
background.)  

If searching for a specific date, the Date Field Search option will need to be used 
(due to the different ways that dates can be formatted). 

 

 
 

3 View the displayed results of the search. (Note:  These results can be filtered in 
order to find the required information.)   

Click in the upper left corner (of each column header) in order to open the filter for 
that column. 
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4 Use these available tools to edit or clear filters in the Global Find. 

 

 

 

5.1.4.2 The Filter Manager 

Step Procedure 

1 Use the Filter Manager, displayed in the lower right. See below. (Note:  To 
change the view to the Filter Manager, click on the appropriate tab at the 
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bottom.) 

 

2 Modify the Filter Settings or cancel the Filter. (Note:  This includes the Quick 
Filter.) 

 

5.1.4.3 Find and Replace     

Step Procedure 

1 Select Data Entry, then select Home > FIND or REPLACE. 
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2 Using the FIND function: 

Select the Search Column. 

Fill in the data to search for in FIND. 

Select the option for Whole Word or use a Wildcard. 

Use the FIND NEXT button to scroll through records. 
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3 Using the REPLACE tab 

Select the Search Column. 

Fill in the data to FIND and REPLACE WITH. 

Select the option for Replace All, Find Whole Words, or use Wiildcard. 

Use the FIND NEXT button to scroll through records in order to change only 
specific records not all of them. Then click REPLACE, only that record is 
changed. 

 

 
 

 

5.1.4.4 Quick Filter 
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Step Procedure 

1 Select Data Entry, then select Home > Quick Filter. 

 

 
 

2 Access the Quick Filter window to view and search through the data fields in 
your designated template. 

 

 
 

3 Fill out the different fields (required for the search). Click OK. 

 

5.1.5 Selecting Select – Select All, DeSelect All, Select Record, and 
DeSelect Record  
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5.2 Selecting the Database tab 
Import/Export allows you to import data from prior 5.x versions of Asure ID using the 
Wizard. (Note:  This allows you to import data into the template from external sources and/or 
save data from the template into an external database format. This manages the records.) 

You can export templates and data by selecting the specified templates in the Export Wizard. 
Options for exporting include ALL, SELECTED OR CURRENT records.  

 

       
 

The Records offers the Refresh, Archive and Restore options for managing the records in 
the database. 
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5.2.1 Selecting Import Wizard 
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5.2.2 Selecting Export Wizard 

 

5.2.3 Selecting Refresh 

 

5.2.4 Selecting Archive 
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5.2.5 Selecting Restore 

 
 

5.2.6 Setting up Asure ID (to only load X number of records) 

Step Procedure 

1 Open Asure ID 7 and access the Options menu. 
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2 Choose the required Template in the column on the left side. See below. 

 

 
 

3 Under Database Query Options, set the value to the number of records (that you 
want the software to load when the templates are opened). 

You must select a value greater than 50 and less than 500,000. 

 

 
 

 

5.2.7 Importing Card Data (for SQL DB in Data Entry)  
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The purpose of this is to Import card data for SQL DB in Data Entry  

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Data Entry application. 

4 Select template associated with data to be imported. 

5 Access the Database tab on the Ribbon and select Import Wizard. 

 

6 After clicking Next in the initial Import Wizard dialog, select the SQL Import Source 
Type for the list. 
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7 Specify the Server Name from dropdown. 
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8 Specify the Initial Catalog name. 

9 Specify the User Name and Password. 

10 Check the Use Integrated Security Checkbox if necessary. (Note:  This feature 
uses the Windows Login information not assigned Login information.)  

 

 

11 Select Next. 

12 Select the specific table from the provided list that contains the specified data. 

13 Select the template from the dropdown that contains the data. 

14 In the Field Links dialog, you can map the data fields from Import Source fields to 
the fields on the template by highlighting a field from each box and clicking add. 
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15 After all required fields are mapped, click Next. 

16 In the Import Options dialog, you have these Import options: 

Update Existing Records  

Import New Records 

Import New Records Only  

Update Existing Records Only 

17 Click Next.  

18 Clicks Begin Import and Next. The records are imported.  

19 Click Finish. 

21 From the Application Menu, open that template to refresh the records.  

 

5.2.8 Importing Card Data (for Access DB in Data Entry)  

The purpose of this case is to Import card data for Access DB in Data Entry  

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Data Entry application. 

4 From the Application menu, select Open Template from the dropdown menu 
then select the template associated with data to be imported. 

5 Access the Database tab on the Ribbon and select Import Wizard. 
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6 After clicking next in the initial Import Wizard dialog the select the Access 
Import Source Type from the list. 

 
 

7 Select Browse button to locate the database to be imported. 
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8 Specify database password if necessary. 

 

9 Select Table from list. 

10 Select the Table to import into. 

11 In the field links dialog, you can map the data fields from import source to the 
fields on the template by highlighting a field from each box and clicking Add.  

12 After all required fields are mapped, click next. 

13 In the Import Options dialog, you can choose to import all records as new   
records and (then) click on Begin Import. 

14 Records are imported. 

15 Click Finish. 

16 From the Application Menu, open that template to refresh the records.  
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5.3 Selecting the View tab 
5.3.1 Selecting Data Mode, View, and Record Views 

 
 

Under the View tab, you can change how the data records are displayed in the workspace. 

Select View to see the card in two formats.  

Select Record to view records by template with all data presented to user. (Note:  The 
images are visible in this record format.)  

Select Table to view records in a grid / table format. You can see all records. (Note:  The 
images are not visible.) 
Select Record View for the Carousel or Single Row viewing.  

Select Carousel to view one record at a time in a view. (Note:  This view moves when you 
use the arrows or you click on the navigation items at the bottom of the application. The 
images are visible.)  

Select Single Row to view multiple records in a row based on the entire record view. The 
images are visible. 
Select Layout to Customize. (Note:  With this function, you can customize views by 
selecting objects and moving the order or location of the items 

Template card allows you to move data fields around in the view by selecting a field and 
moving it up or down. (Note:  Hidden Items can be moved into or out of the view.)  

View layout allows you to preview your newly customized view. 
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5.3.2 Selecting Layout, Pan, Customize, Fit Grid to View and Reset 
Layout 

 
 
Selecting Pan allows user to scroll templates with large numbers of data fields, which do not 
fit in the current viewing area of the screen, vertically to see and manipulate fields that are 
not currently in view. 
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Selecting Customize allows users to define how the fields and photos and signatures in the template 
are formatted in the Layout View.  These changes are saved and will be recalled the next time the 
template is loaded. 
 

 
 
Selecting Fit Grid To View can be used to toggle if the user can scroll horizontally to view columns 
not currently in view or if all the columns will be condensed into the current view.  Recommended to be 
off for templates that contains a large number of data fields. 
Selecting Reset Layout clears any user customizations to the current view. 
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5.3.3 Selecting Technology – SAM Status 

 
 

5.3.4 Adding Cards without Printing in Data Entry  

The purpose of this Data Entry is to add a card without printing 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Data Entry application. 

4 Access the Application Menu and select Open Template from the dropdown 
menu. 

5 Add a record by going to the Record section on the Ribbon and clicking on Add. 
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6 Click on each field where data entry is required and fills in the appropriate data. 

7 Click the Save icon on the Ribbon. (Note:  a preview rendering of the card will 
display on the right hand preview pane.) 

 
 

5.3.5 Using the Carousel View to reprint cards 

The purpose of this Data Entry is to reprint an existing card. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Access the Data Entry application. 

4 Access the Application Menu and select Open Template from the dropdown menu. 

5 Access the Find section on the Ribbon and select Find. 

7 In the Find dialog, select the specific field for data on the record to be found or 
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leaves Search Column at ALL. 

8 Type in the specific record data in the find field and click Find Next. 

9 Carousel view spins to a specific record, if set up to use Carousel View. 

 

10 Click Cancel to view the record. 

11 Click on the Print icon next to the Application Menu or open the Application Menu for 
the print options. 
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5.3.6 Printing Cards for New Employees  

The purpose of this case is to print a card for a new employee 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Go to the Data Entry application. 

4 Open the Template through the Application Menu. 

5 From the Records tab, select Add. 

6 Fill out the Name and add a Photo by right clicking in the Photo area.  

The Photo may be captured from a camera or loaded from a file.  

The Photo may be edited. 

8 The Photo may also be captured using the Acquire tab. 

 

 
 

9 Select Save. 
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10 Click on the Print icon next to the Application Menu or open the Application 
Menu for the print options. 
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5.4 Screen Layout 
The Application button gives the user the ability to select the following general functionalities 
with options in each. Highlight the icon for the definition of each function.  

Select Open to display recently opened templates in right half of pane. 

Select Print to display print options such as Print Cards, Template Data and Sheet printing.  

Select Preview to display preview options before printing the final card.  

Sheet Printing Settings for printing test cards to a page printer for review. 

Select Standalone Encode is used in iDIRECTOR to read encoded data to be printed on the 
card or stored in the database.  
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5.5 Application Menu 
5.5.1 Open Template 

Open Template allows you to select any previously-saved or imported templates. (Note:  
This allows you to work from pre-existing and predefined templates. Be sure and save your 
work after you make additions to your template.) 

Click on the Application Menu icon to open the Application Menu. 

Click on Open Template to bring up the Open Template window and access an existing, 
predefined template (for your use).  

Select the required template and click on OK to open up a template file.  

Click on Cancel to close out the window without accessing a template file. 
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5.5.2 Record Viewing 

You can select the Data Entry application (Multiple Record view) to display a data grid.  
Presentation:  Each individual data field is presented in the horizontal axis. Each data 
record in the data set is presented in the vertical axis.  

Preferred Viewing:  The view is preferable when entering large numbers of dates. 

Sample Window:  See the Data Entry application Window Table view (below). 

 

5.5.3 Open Data View 

Data Views are similar to Live Links. (Note:  However, a Live Link is just for one template. 
Once a Data View is created, it can be used across multiple templates.) 

Data Views allows you to set up relationships between tables.   

Data Views must be set up before you can create a template to use this data source. 

Once a Data View is set up for a template, the Live Link option is no longer available for that 
template. 

Step Procedure 

1 To create a Data View, in the Card Design application, click on the Card Setup tab. 

2 In the Live Link portion of the Ribbon, choose Data View. 

Select Create of Edit a Data View. See below. 

 

 

3 View the Data View Manager window. 



© 2011 HID Global Corporation   All rights reserved 

211 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

4 Add a Data Source by clicking on the Add Data Source icon in the Ribbon. (Note:  
The process here is the same as setting the data source for a Live Link.) 

 

 

5 View the tables for that Data Source along the left side of the window (once that 
Data Source has been set up). 

6 Add these tables to the Data View. 

Highlight the table (you would like to add).  

Click the Add table button. 
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7 Join the tables once they (the tables) are added to the Data View. (Note:  The tables 
must be related by the field in the primary table, as it relates in turn to the Key field in 
the secondary table.) See below. 

Example (procedure):   

Select the Department field in the Employees table.  

Select the DepartmentID (key field) in the Departments table.  

Click on the Add Join button in the Ribbon. 

 

8 Note in the Data View. 

All the table fields are listed, which allows you to use those fields, as required.  

You may need to remove, rename, or add back in fields by using the three (3) small 
icons in the table headers. See below. 

 

9 Save the Data View once you set it up. (Note:  This will close the Data View 
Manager window.) 
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10 Link the Data View to your template. (Note:  It will be used in your template as a 
Data Source.)  
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11 Select the Data View to link to your template. Click OK. 

 

12 In the Advanced options of data fields, you can change the source to the Data View. 
(Note:  The name of the source is listed here. It is not the name of the Data View.) 
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5.5.4 Print 

Printing from the Data Entry application is accomplished by clicking the application button 
(upper left corner of the screen) and selecting the Print option or Print button. 

If you are in the single record view, the data record displayed will be printed on the card 
printer. 

If you are in the multicard view, all selected records will be printed on the card printer. 

Printing options appear in the dropdown menu. Select the required option. 

 

 
 

Follow these instructions: 

Select the printer.  

Set the driver properties. 

 

  start here  
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5.5.5 Printing Cards with Data in Data Entry 

The purpose of this case is to print a card with data 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Go to the Data Entry application. 

4 From the Application menu, select Open Template from the dropdown menu. 

5 From the Records option on the Home tab click on Add. 

      6 Click on each field where data entry is required and fill in the appropriate data. 

7 Click the Save icon on the Ribbon. a preview rendering of the card will display 
on the right hand preview pane. 

  

 
1.  

8 1. Click on the Print icon next to the Application Menu or open the 
Application Menu for the print options. 
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Section 6:  Using the Reports Application 
The Reports application supplies you with a number of preformatted report options dealing 
with the operation of the application.  

Launch the Asure ID 7 software. 

Enter your User ID and Password in the appropriate areas. 

The Reports are broken down into 3 Categories. 

User Reports 

Data Entry Reports 

Card Design Reports 

 

6.1 Selecting the Home tab 
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6.1.1 Selecting User List – User Reports 

 

6.1.2 Selecting User Activity – User Reports 

 

6.1.3 Selecting User Login – User Reports 
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6.1.4 Selecting All Records for a template – Data Entry Reports 

 

6.1.5 Selecting Records with no Photos – Data Entry Reports 

 

6.1.6 Selecting Unprinted Records – Data Entry Reports 
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6.1.7 Selecting Voided Records – Data Entry Reports 

 

6.1.8 Selecting Template History – Data Entry Reports 

 

6.1.9 Selecting Print History Report – Data Entry Reports 
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6.1.10 Selecting Template List – Card Design Reports 

 

6.1.11 Selecting Data Fields for Template – Card Design Reports 

 
 

6.1.12 Selecting Refresh – Data 

Once a report has loaded into the preview window, the data being displayed can be 
refreshed using the Refresh Data button. (Note:  Report exports in the DevExpress reports 
format.) 
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6.1.13 Selecting Export – Data 

Once a report has loaded into the preview window, it can be exported to one of several 
formats. The available formats include: 

PDF (requires Adobe Acrobat to view) 

RTF (rich text format) 

Excel (Requires Microsoft Excel or equivalent viewer to view 

 

 
 

6.1.14 Save Custom Report – Data 
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6.2 Selecting Custom Reports – Private Reports 

 
 

6.3 Selecting Print Report 
With a report loaded in the preview window, click Print Report from the application menu. 
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6.4 Generating Reports    
The purpose of this case is to generate a Report. 

Step Procedure 

1 Launch the Asure ID 7 software. 

2 Enter your User ID and Password in the appropriate areas. 

3 Go to the Reports application. 

4 Select the Report Type for User Reports, Data Entry Reports,  Card Design, or 
Data Reports.  

5 Select the Report Name   Print History Report for this example. 

 

 
 

6 Once a report has loaded into the preview window, the data being displayed can 
be refreshed using the Refresh Data button. (Note:  Report exports in DevExpress 
Reports format.) 
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7 Exporting the Report 

Once a report has loaded into the preview window, it can be exported to one of 
several formats. The available formats include: 

PDF (requires Adobe Acrobat to view) 

RTF (rich text format) 

Excel (Requires Microsoft Excel or equivalent viewer to view 

 

 
 

8 When selecting an Export option, you will be prompted for a location to save the 
file. Choose a folder and click the Save button to continue. 

9 Printing a Report 

With a report loaded in the window, click Print Report from the application menu. 
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6.5 Using the Custom Report Feature  

Step Procedure 

   1 An existing or new report may be edited or filtered and saved for future use as a 
Custom Report.  (Note:  You can create a unique name for the report. It may be 
saved as a public or private report.) 
   

 
 

2 Any report column may be grouped by left clicking and dragging the column header up 
above the grid to the Grouping section. This allows for your unique sequence of lining up 
the headers for the report.  
 

 
 

3 Select the Button to filter and view the report data. This will further customize your report.  
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4 Right click on the TAB to sort the Report data. Each column may be altered with these 
options, as shown below. 
 

 
 

5 Once the Custom Report is Saved, it is available for viewing from the Home Ribbon.   
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 The Custom Report may be Run again or Deleted or Renamed.  
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Section 7:  Options Menu  
This menu displays controls used to perform actions like Save and Print. It also provides a 
list of recent documents, access to application options for changing user settings and 
preferences and application exit. 

The OPTIONS section provides instructions on Language, Rendering, Skins, Resources, 
Printing, Advanced Printing, Encoding, Licensing, Card Design and Devices.  
From the Application Menu, click on Options to bring up the choices, as shown below. You 
will be using the processes or functions on this dropdown menu repeatedly.  

Select the appropriate work task or process by clicking on the icon. You will bring up the 
respective dialog in order to work within that task or process. 
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7.1 Choosing a Language (Options) 
Follow these instructions: 

Select the required (available) language, as shown below. 

Click OK to accept the option. Click on Cancel to exit without saving your work. 

 
   

7.2 Selecting the Template options 
Default Image Format: Png is the default image format used in Asure ID 7. This option 
provides the ability to override this default image format from within the Photo and Signature 
property dialog.  Set up the desired format for your image.  This will be applied when you use 
the PHOTO or SIGNATURE option in CARD DESIGN.  
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7.3 Choosing Skins (Option) 
Follow these instructions: 

Select the radio button for the Skins or background, as shown below. 

Select different skin to change the background colors and theme of Asure ID 7. 
Click OK to accept the option. Click on Cancel to exit without saving your work. 

 

7.3.1 Choosing a Different Skin (Upper Left Icon > Options > Skins) 

Step Procedure 

1 Open Asure ID 7 and go to the Options menu. 

 

 

2 Choose Skins in the LEFT SIDE column. 
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Choose the appropriate Skins color option to meet your requirements. 

 
 

7.4 Viewing the Resources window  
This About window has the specific version number for Card Design, Data Entry, Reports, 
and User Config. 

Select the checkbox for automatic software updates when the program is opened. Internet 
access is required for this process.       
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7.5 Choosing Printing Settings  
Set Print Button - Use this item to configure the behavior of the main Print function button on 
the Data Entry Center screen. When selected, a dialog box (shown below) will appear, and 
allow you to set the options.  

By default, the 'Print' function button will print all cards in the current template that have not 
yet been printed, and will first bring up the 'Printers' dialog, allowing you to choose a printer 
and print driver settings for the current job. 

Using the 'Set Print Button' function, it can be configured to print 'All Cards', 'Selected Cards 
''Unprinted Cards' or the 'Currently Displayed Card'.  

Additionally this option can be used to override the automatic appearance of the 'Printers' 
dialog, by clearing the available option box, and can also be used to have the 'Print Preview' 
window automatically appear prior to printing. 

Follow these instructions. See the display on the below for a reference. 

Select Auto-detect, Native Commands, Flatten Image for Printing, Stretch, Center, and No 
Adjustment options (shown below). 

The left side is the rendering method used for printing. 

Auto Detect:  Asure ID will determine when to pre-render, based on the type of objects on 
the card, and the capabilities of the printer. This is the default setting which should be used 
for the majority of printing operations. In this mode the system will evaluate the objects and 
look for alpha channel values or chroma key values that might not render properly if drawn 
directly to the printer and if found it will than flatten the image. 
Native Commands:  Draws the GDI+ commands directly to the printer's device context.  

Flatten Image for Printing:  Renders all the objects to a bitmap in memory and then sends 
down the bitmap to the printer. 

The right side is the position that the image will be rendered to the printer. This is only 
applicable when the page size of the printer is larger than the card size, such as on our HDP 
series printers. On DTC printers, where the page size is equal to the card size, all 3 options 
will print the exact same.  

Stretch:  The background (if there is one) will be stretched to fill the page size (basically so 
our HDP printers will print edge to edge) while centering the other objects so that they should 
print where they are expected to on the card design. 
Center:  The background is not stretched and everything else is centered so that the objects 
are printed where it is expected in the card design. Many times this method won't quite print 
edge to edge. 
No adjustment:  All objects are rendered from the corner (which on the HDP printer is 
actually off the card). Basically "No Adjustment" will not try and compensate for the page size 
to card size discrepancy and will have the effect of shifting the entire card (on a portrait 
image) up and to the left. 
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7.6 Choosing Advanced Printing Settings  
This dialog is used to configure the printer‟s chip encoding and magnetic encoding command 
sequences. Follow these instructions: 

Input the appropriate Feed Card to Proximity Card Encoding position, Feed Card to 
Contactless Card Encoding position, Feed Card to Encoding position, and Eject Card from 
any position.  

Set up the magnetic stripe Encoding commands. 
Click on Update Device List to update the list (as needed). 

Click OK to accept the option. Click on Cancel to exit without saving your work. 
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7.7 Selecting Encoding 
Follow these instructions:  
Under Magnetic stripe, select the printer used for an advanced encoding setting. (Note:   
Asure ID will try to find the best profile by matching the keywords. The magnetic stripe is 
similar to a barcode and encodes information from your existing data fields.)  

iDIRECTOR/Smart Card Settings are used to configure the reader and port assignments. 
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New pic 

7.8 Choosing Licensing Settings 
This stores user information and license keys that will aid in troubleshooting and providing 
assistance if you forget or misplace your key. (Note:  This must be done prior to using 
software or to convert from trial software to fully activated software.) 

Follow these instructions: 

Click Licensing to bring up the Licensing button and window. 

Fill in the fields. 

Check box for the option to Subscribe to product newsletter or anonymous surveys.   

Click either Phone Activation or Activate Online. 

Click OK when complete. 
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7.9 Choosing the Card Design option 
Use this option to set the default parameters for the Text Label, Data Field, and Compound 
Field formatting.  

 The options for Font, Alignment, Placement and Border/Fill will use these default settings in 
CARD DESIGN when TEXT LABEL, DATA FIELD AND COMPOUND FIELD are selected. 

You can test the TEXT SAMPLE in the Preview box. 
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7.10 Choosing the Devices option 
Use this section to set up your camera and/or signature pad devices. Follow these 
instructions after clicking the Devices button: 

Select the Camera Type under Photo Device. 

Click on Update Device List to update the list (as needed). 

Select the Device Type option under Signature Devices, as shown below. 

Click OK to accept the option. Click on Cancel to exit without saving your work. 
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Section 8:  Data Connection 
8.1 Creating a new Native Database (Access, SQL, 
and Oracle)  
When Asure ID 7 is installed, it will use an Access database. This database stores some configuration 
tables, as well as template and cardholder data. If using SQL Server or Oracle as the native database, 
follow these steps. 
 
Step Procedure 

 
 

1 
 
 

Your system admin or dba will need to execute a set of scripts to create all the 
database objects needed for Asure ID 7. (Note:  The application needs to be 
pointed to the new database. If the database is not found you have the option to 
generate a new database by choosing the required path. With the next startup the 
new database will be accessed)  

 
2 To install the scripts: 

Go to the Asure ID installation directory (the default folder is C:\Program Files\ 
HID Global\Asure ID\Scripts on 32-bit operating systems and C:\Program Files 
(x86)\HID Global\Asure ID\Scripts for 64-bit operating systems). You will find two 
files: 

AsureID_MSSQL.sql  

AsureID_Oracle.sql 

The Admin authority will need to run whichever set of scripts is applicable in the 
chosen database. 

They will also need to create a user that has SELECT, INSERT, UPDATE, 
DELETE and CREATE privileges. 

 
3 Once objects are created in the database, access the following: 

[start]   

[All Programs] 

[HID Global] 

[Asure ID] 

[Data Connection Wizard] 
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4 Click Next. 

 
5 Select the correct database. (Note:  Access is only listed so that in the event you 

want to re-point the system back to the Access database that was installed with 
the application. Any other Access databases are not a valid option for a native 
datasource.) 
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   6 Enter the parameters needed to connect to the newly created database. 

This is where the user/password will be needed and is the user that will connect 
with all Asure ID users. (Note:  In other words, they will only need one database 
user/password.)  

ALL users added to Asure ID 7 will use this user/password when working in Asure 
ID 7. (Note:  This will not be visible to Asure ID users.) 
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7 This information now resides in the PC registry and will remain persistent (unless it 

is changed using the Data Connection Wizard). 

Re-pointing the database does not migrate data. (Note:  This will need to be done 
manually.) 

Now any new templates added in Asure ID 7 will be saved in the new datasource. 
(Note:  The Access database installed with the system will no longer be used.) 
When using Asure ID 7 for the first time after making this change, the only valid user will 
be the “admin” user. 
 

 
 

    
8 Click Finish.  This will test connection and show message. 
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Appendix A- Data Entry Keyboard Shortcuts  
Data Entry Keyboard Shortcut List for Asure ID 7 

<CTRL> + A Select All 

<CTRL> + <SHIFT> + A Deselect All 

<CTRL> + C Copy to Clipboard 

<CTRL> + F Find 

<CTRL> + H Replace 

<CTRL> + I Capture Photo 

<CTRL> + L  Load Photo from File 

<CTRL> + O Open Template 

<CTRL> + P Print Card 

<CTRL> + Q Quick Filter 

<CTRL> + R Set View to Record View 

<CTRL> + S Save Record 

<CTRL> + T Set View to Table View 

<CTRL> + V Paste from Clipboard 

<CTRL> + X Cut to Clipboard 

<CTRL> + <Delete> Delete Record 

<CTRL> + <Insert> Add Record 

<CTRL> + <Space> Toggle Select 

<CTRL> + <F2> Open Preview  

<CTRL> + <F11> Switch to Template View Mode 

<CTRL> + <F12> Switch to DataView Mode 

<ALT> + <F4> Exit Application 

<F3> Find Next 

<F5> Refresh Database 
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Appendix B – Card Design Keyboard Shortcuts 
Card Design Keyboard Shortcut List for Asure ID 7 
 

<CTRL> + A Select All 

<CTRL> + C Copy to Clipboard 

<CTRL> + N Show New Template Dialog Box 

<CTRL> + H Replace 

<CTRL> + O Open Template 

<CTRL> + P Print Template 

<CTRL> + S Save Template 

<CTRL> + T Toggle Preview Mode 

<CTRL> + V Paste from Clipboard 

<CTRL> + W Close Template 

<CTRL> + X Cut to Clipboard 

<CTRL> + Y Redo 

<CTRL> + Z Undo 

<CTRL> + <F2> Open Preview  

<ALT> + <F4> Exit Application 
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Appendix C- iCLASS Programming Guide  
      
Creating an iCLASS Card 

The purpose of this procedure is to program and personalize an HID iCLASS card with HIDs 
Physical Access application. Required for this procedure are: 

Configured iCLASS Credentials 

iCLASS Programming Platform Encoder (SDI) installed within a Fargo HDP 5000 Printer 

iCLASS Programming Platform Smart Card (SAM) containing a specific facility code and the 
number of credential credits purchased 

The iCLASS Programming Platform Smart Card (SAM) enables access to the HID Access 
Control Application on the iCLASS card.  It does not enable applications to be written to any 
other areas within the iCLASS card. 

Fargo HDP 5000 or HDPii Printer 

Asure ID 7+ Card Personalization Software (Exchange Edition) 

In order to use the iCLASS Programming Platform, the system should meet the same 
minimum requirements as stated by Asure ID. 

An external OMNIKEY contact reader (3121, 5321 or 5325 USB) 

 

Configured, non-programmed iCLASS Credentials:   Please order these cards through your 
normal order process.   

The programming information is added to the card through the use of this product. 

The iCLASS Programming Platform utilizes configured but non-programmed cards as its 
base. 

 

iCLASS Programming Platform Encoder (SDI) installed within a Fargo HDP Printer.  Please 
verify if you already have an HDP 5000 printer.  If yes, then just order the appropriate 
encoder upgrade module off the iCLASS Programming Platform order guide.  If you do not 
have a HDP 5000 printer then please order the printer with the encoder already installed.  
Please contact your HID sales manager for the appropriate part numbers. 

Please Note: The iCLASS Programming Platform Encoder can only be used to prepare an 
iCLASS card for usage by completing the programming of PAGE 0.  This encoder cannot be 
used to add application data to other pages of the iCLASS card.  Another encoder must be 
used to add applications to an iCLASS or MiFare card. 

 

iCLASS Programming Platform Smart Card (SAM) containing a specific facility code and the 
number of credential credits purchased 
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The Smart Card enables access to the HID Access Control Application on the iCLASS card.  
It does not enable applications to be written to any other areas within the iCLASS card. 

 

Asure ID 7+ Card Personalization Software (Exchange Edition) 

In order to use the iCLASS Programming Platform, the system should meet the same 
minimum requirements as stated by Asure ID. 

 

An external OMNIKEY contact reader (3121, 5321 or 5325 USB) 

 

Creating a template in Card Design 

Make sure the SAM card is inserted into an external OMNIKEY contact reader (3121, 5321 
or 5325 USB) 

Access the Card Design Center application in order to create a new template or open an 
existing template for use with the SAM write capability.  

Add the iCLASS Smart Chip to the template 

From Card Setup tab, select Enable Smart Chips and select iCLASS from the dropdown list. 
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4)  The iCLASS Chip Properties dialog is displayed. 

 

5)  From the Actions group in the iCLASS Chip Properties dialog, select Add an Application. 

  
 

     6)  An iDIRECTOR wizard will open.  Select Next 
 
a.   Using the new application called iCLASS Card Programming (SAM), you can specify 
that the SAM will program the card once the card is encoded. 

 

This option will only be available if a SAM card is inserted into a supported external contact 
chip reader at the time the application is added.   

 

7)    Select iCLASS Card Programming (SAM), and press the Next button. 
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8)  On the Application Configuration page, only one format will be listed (the configuration 
supported by the SAM).  Make sure it is selected and press the Next button. 
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9)  On the Application Properties page press the Next button. 

 
 

10)  Verify the “Create a Data Field for each iDIRECTOR field” box is checked and press the 
FINISH button.     
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11)  At this point the application has been added and will appear as a new tab in the iCLASS 
Chip Properties dialog.  Press OK to confirm the change. 

 

 
 

12)  Once added, the iCLASS SAM application becomes visible in the Card Properties 
window on the iDIRECTOR tab in the Smart Chip Applications tree. 

 

 
 

Make any changes or updates to the template and then SAVE the template 
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.  

 

 

  Name the file and select OK 
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Encoding iCLASS cards using the SAM in Data Entry 

 

Select the ID icon to access the OPEN TEMPLATE and OPTIONS. 

   
 

From the ID icon- open the template created in the previous section. 

 

 
 

From the ID icon open the Options dialog and select the Encoding tab. 
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Select the iCLASS icon and choose an HID iCLASS Programming Platform Reader from 
the Reader and Port section. 

 

 
 

Make sure the Use printer’s internal encoder option is selected. 

Press OK to confirm the Reader and Port selection and exit the dialog. 

An additional setting may need to be modified in the Asure ID database. (EncodeDelay entry 
to the Asure ID HDP 5000 printer table). 

Contact HID Technical Support for questions and assistance configuring the Asure ID 
database for your specific printer model. 

Add records and data field values in Data Entry. (Note: In addition to the template data fields, 
the parameters (required for the iCLASS credentials) are shown in this view.) 

 

   (Add single or batch records) 

 

If the parameter is User Configurable, as determined by the SAM order parameters, the field 
is enabled and the value can be entered in Data Entry. 
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SAM Status dialog showing SAM card with User Configurable Card Id Number 

 

If the parameter is not User Configurable, the field will be indicated as Read Only.  (NULL) 

Check the SELECT box for each record to encode.  
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Print and encode the selected card(s) with the Print option from the Application Menu. 

 

 
 

The first time the SAM is used it still contains the default (factory) password from HID. In this 
case you are prompted to change the SAM password. 

 

 
 

The Old Password field will be disabled and does not need to be entered. 

 

Enter your unique password in the New Password and Confirm New Password fields. 
(Note: If these fields are left blank, the default (factory) password will be retained and you will 
not be prompted to enter the password prior to printing/encoding. 



© 2011 HID Global Corporation   All rights reserved 

258 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

 

Press the OK button to accept the password change. (Note: Alternatively, the password can 
be changed from SAM Status on the View tab in both Card Design and Data Entry.) 

 

You will be asked for the SAM password when a card is encoded in a Data Entry session.  

 

 
 
Enter the SAM password. ( Note: KEY box for password entry)  

Press OK. (Note: The password will be cached, and it will not be required again during this 
session of Data Entry.) 

 

 

If the password is entered incorrectly, the SAM will be “locked” for several seconds. (Note: 
Each subsequent invalid authentication attempt will add additional locking time.) 
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A progress bar indicating the Status of the printing and/or encoding process is displayed. 

 

 
 

An error message will be displayed if there was an error during the printing and/or encoding 
process.  

(Note: If the card fails to encode the card, the card must be ejected from the printer before 
the process is started over again.) 
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SAM Status 

From the View tab in either Card Design or Data Entry, select SAM Status button to view the 
current SAM data. Note: The SAM card contains the credential information (iCLASS keys 
and format) purchased from HID. 

 

 



© 2011 HID Global Corporation   All rights reserved 

261 

Asure ID 7.2 Software User Guide (L001235 Rev. 1.7)  
 

 
Card Status: Indicates if the SAM card is connected with the contact reader and 
communicating with Asure ID. 
Unique ID: Represents a 12 byte field that will be displayed in a hexadecimal format (e.g., 
1A-2B-3C-4D). 

Format Type:  Indicates the encoding algorithm used to encode the iCLASS card. 

Version: version of the SAM card 
Available Credentials: Indicates how many of the purchased credentials are still available to 
encode iCLASS cards. 

 

When there are no available credentials, the SAM card can no longer be used to encode 
iCLASS cards.  

A new SAM must be purchased from HID.  

 

Number of Credentials Used: Indicates how many of the purchased credentials have 
already been used to encode iCLASS cards. 

Sales Order Number:  HID sales order 

Expects Configured card: Entry is Yes or No 

 

Change SAM Password button: Allows the SAM password to be modified. The SAM comes 
with a default password from HID that is the same for all SAM cards purchased. 

 

The user is prompted to change this default password to a more secure password the first 
time a SAM is used to print/encode a card in Data Entry.  

 

Refresh button: Reads the SAM and updates the dialog with the current information 
contained on the SAM 
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The Order Parameters section indicates all fields that will be written to the iCLASS card.  

 

 

 

 

 

 

 

 

 
Parameter column:  Displays the iDIRECTOR field name. 

 

User Configurable column: Indicates Yes if you can enter values for the parameter in Data 
Entry or No if the parameter is Read Only. 

 

Value: Indicates the Read Only value that will be written to the card. (Note: The parameters 
and their configurable status are managed in the SAM order process with HID.) 

 

The value for a User Configurable parameter is entered into Data Entry prior to the 
print/encode operation. 
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